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 1
I n t r o d u c t i o n
This guide describes the Metal Processing Module, an optional add-on package 
for the COMSOL Multiphysics® simulation software. The module is designed to 
perform transient analyses of processes involving metallurgical (solid-solid) phase 
transformations in, mainly, steels. This chapter introduces you to the capabilities of 
the Metal Processing Module and includes a summary of the physics interfaces and 
where you can find the documentation.

In this chapter:

• About the Metal Processing Module
 7
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Abou t  t h e  Me t a l  P r o c e s s i n g  Modu l e

In this section:

• What Can the Metal Processing Module Do?

• Where Do I Access the Documentation and Application Libraries?

What Can the Metal Processing Module Do?

The Metal Processing Module can be used to model different physical phenomena 
related to heat treatment of metals. Using this module, you can study how 
metallurgical phase transformations change the microstructure of a metallic material 
during a heating or cooling process. One example is the quenching of automotive steel 
transmission components, where the resulting microstructure is tailored to meet 
specific demands on strength and durability. Other examples include the study of phase 
transformations that occur during additive manufacturing of metal components and 
phase transformations in the heat-affected zone during welding.

There are five physics interfaces in the Metal Processing Module:

• The Metal Phase Transformation interface for studying diffusive and displacive 
metallurgical phase transformations in materials like steels.

• The Austenite Decomposition interface for specifically studying the cooling of steel 
from an austenitic state.

• The Alpha-Beta Phase Transformation interface for specifically studying thermal 
transients in α-β titanium alloys.

• The Carburization interface for studying the heat treatment process of 
carburization.

• The Heat Transfer with Phase Transformations interface for modeling thermal 
processes involving metallurgical phase transformations.

• The Steel Quenching interface for modeling coupled thermal and mechanical 
processes involving metallurgical phase transformations.

Throughout the Metal Processing User’s Guide, the Metal Phase Transformation, the 
Austenite Decomposition, and the Alpha-Beta Phase Transformation physics interfaces 
are collectively referred to as phase transformation physics interfaces.
1 :  I N T R O D U C T I O N



The physics interfaces in the Metal Processing Module can be added from the Model 
Wizard’s Select Physics page under Heat Transfer>Metal Processing. The physics 
interfaces can also be added by right-clicking a Component node and selecting Add 

Physics.

Where Do I Access the Documentation and Application Libraries?

A C C E S S I N G  T H E  M E T A L  P R O C E S S I N G  M O D U L E  D O C U M E N T A T I O N

The Metal Processing Module feature information, including theory and modeling 
details, is included in the Metal Processing Module User’s Guide.

When you install COMSOL Multiphysics, the documentation sets are installed in 
several locations, both on your computer and most easily accessible while you are 
working in COMSOL Multiphysics. The next section details where to access it.

A C C E S S I N G  C O M S O L  D O C U M E N T A T I O N  A N D  A P P L I C A T I O N  L I B R A R I E S

A number of online resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 
context-based) help, and the Application Libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes the core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions on how to use COMSOL Multiphysics and how to access the electronic 
Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop. 
To learn more about a node in the Model Builder, or a window on the Desktop, click 
to highlight a node or window, then press F1 to open the Help window, which then 
displays information about that feature (or click a node in the Model Builder followed 

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.
A B O U T  T H E  M E T A L  P R O C E S S I N G  M O D U L E  |  9
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Opening the Documentation Window

T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each model or application includes documentation with the theoretical background 
and step-by-step instructions to create a model or application. The models and 
applications are available in COMSOL Multiphysics as MPH-files that you can open 
for further investigation. You can use the step-by-step instructions and the actual 
models as templates for your own modeling. In most models, SI units are used to 
describe the relevant properties, parameters, and dimensions, but other unit systems 
are available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the model or application and 
its properties, including options to open it or its associated PDF document.

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder, click a node 
or window and then press F1.

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help ( ) 
button.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu, select Help>Documentation ( ).

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.
 1 :  I N T R O D U C T I O N



Opening the Application Libraries Window
To open the Application Libraries window ( ):

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and a case number will be sent to you 
by email. You can also access technical support, software updates, license information, 
and other resources by registering for a COMSOL Access account.

From the File menu, select Application Libraries.

To include the latest versions of model examples, from the File>Help menu 
select ( ) Update COMSOL Application Libraries.

From the File or Windows menu, select Application Libraries.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Libraries.
A B O U T  T H E  M E T A L  P R O C E S S I N G  M O D U L E  |  11
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C O M S O L  O N L I N E  R E S O U R C E S

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/product-update

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/forum

Events www.comsol.com/events

COMSOL Application Gallery www.comsol.com/models

COMSOL Video Gallery www.comsol.com/videos

Support Knowledge Base www.comsol.com/support/knowledgebase
 1 :  I N T R O D U C T I O N
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Ove r v i ew o f  t h e  U s e r ’ s  Gu i d e
T A B L E  O F  C O N T E N T S  A N D  I N D E X

To help you navigate this guide, see the Contents and Index sections.

M O D E L I N G  W I T H  T H E  M E T A L  P R O C E S S I N G  M O D U L E

The Metal Processing Modeling chapter discusses how to model different problems 
involving phase transformations. The content covers the topics Selecting Physics 
Interfaces, Study Types, Modeling Phase Transformations, Defining Multiphysics 
Models, Selecting Discretizations, and Using Effective Material Properties.

M E T A L  P R O C E S S I N G  T H E O R Y

The Metal Processing Theory chapters outlines the theory for the interfaces present in 
the Metal Processing Module. The chapter covers the topics Metallurgical Phase 
Transformations, Compound Material Properties, Phase Transformation Strains, 
Phase Transformation Latent Heat, and Carburization.

T H E  M E T A L  P H A S E  T R A N S F O R M A T I O N  I N T E R F A C E

The Metal Phase Transformation chapter describes the Metal Phase Transformation 
interface and its feature nodes.

T H E  A U S T E N I T E  D E C O M P O S I T I O N  I N T E R F A C E

The Austenite Decomposition chapter describes the Austenite Decomposition 
interface and how it is based on the Metal Phase Transformation interface.

T H E  A L P H A - B E T A  P H A S E  T R A N S F O R M A T I O N  I N T E R F A C E

The Alpha-Beta Phase Transformation chapter describes the Alpha-Beta Phase 
Transformation interface, and how it is based on the Metal Phase Transformation 
interface.

T H E  C A R B U R I Z A T I O N  I N T E R F A C E

The Carburization chapter describes the Carburization interface and its feature nodes.
O V E R V I E W  O F  T H E  U S E R ’ S  G U I D E  |  13
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M U L T I P H Y S I C S  I N T E R F A C E S  A N D  C O U P L I N G S

The Multiphysics Interfaces and Couplings chapter describes two multiphysics 
interfaces found under the Metal Processing branch when adding a physics interface:

• The Heat Transfer with Phase Transformations interface combines a Metal Phase 
Transformation interface with a Heat Transfer in Solids interface. The coupling of 
the interfaces appears on a domain level, where produced latent heat from the 
(temperature-dependent) phase transformations gives rise to a heat source in the 
heat equation. Optionally, phase-composition-dependent thermal material 
properties can be used in the heat transfer analysis.

• The Steel Quenching Interface combines an Austenite Decomposition interface 
with a Heat Transfer in Solids interface and a Solid Mechanics interface. There are 
two domain-level multiphysics couplings: In the first coupling, produced latent heat 
from the (temperature-dependent) phase transformations gives rise to a heat source 
in the heat equation. In the second coupling, phase transformation strains that result 
from thermal expansion or transformation-induced plasticity (TRIP) are transferred 
to the Solid Mechanics interface as inelastic strain contributions for the computation 
of stresses. In the case of plasticity, the coupling also involves equivalent plastic 
strains and hardening functions. Optionally, phase-composition-dependent thermal 
and mechanical properties can be used in the heat transfer and solid mechanics 
analyses.

• The Phase Transformation Latent Heat multiphysics coupling adds the latent heat 
that is produced during phase transformations, as a heat source term, to the heat 
equation in a Heat Transfer interface.

• The Phase Transformation multiphysics coupling adds the transformation strains 
that are produced during phase transformations, as an inelastic strain contribution, 
to the equation for stress in a Solid Mechanics interface. The coupling also transfers 
stresses and the equivalent plastic strain from a Solid Mechanics interface to the 
coupled phase transformation interface.
 1 :  I N T R O D U C T I O N



 2
M e t a l  P r o c e s s i n g  M o d e l i n g
The goal of this chapter is to show you how to model different problems involving 
phase transformations in steels and how to include various physical phenomena that 
may be relevant in specific situations.

In this chapter:

• Selecting Physics Interfaces

• Study Types

• Modeling Phase Transformations

• Defining Multiphysics Models

• Selecting Discretization

• Using Effective Material Properties

• Importing Material Properties and Phase Transformation Data

• Modeling Carburization
 15



16 |  C H A P T E R
S e l e c t i n g  Ph y s i c s  I n t e r f a c e s

The Metal Processing Module contains three basic physics interfaces and two 
multiphysics interfaces. The three basic physics interfaces are:

• Metal Phase Transformation — For modeling general metallurgical phase 
transformations

• Austenite Decomposition — For modeling the specific case of austenite 
decomposing into a combination of destination phases, on cooling

• Alpha–Beta Phase Transformation — For modeling phase transformations in α–β 
titanium alloys.

• Carburization — For modeling carburization; the process by which carbon from a 
surrounding carbon rich environment diffuses into a component.

Metal Phase Transformation

The Metal Phase Transformation interface provides a basic way to model phase 
transformations in metals. Four common models for phase transformations in steels are 
provided. The Leblond–Devaux, the Johnson–Mehl–Avrami–Kolmogorov (JMAK), 
the Kirkaldy–Venugopalan, and the Hyperbolic rate models are used to model 
time-dependent (diffusion-controlled) phase transformations, such as the 
transformation of austenite into pearlite during steel hardening. In contrast, the 
Koistinen–Marburger model is used to model the transformation of austenite into 
martensite, where the amount of undercooling below the so-called martensite start 
temperature controls the formation of martensite. In addition to these five types of 
phase transformations, you can define your own phase transformation models and let 
them coexist with other active phase transformations in your analysis. You can use an 
arbitrary number of phase transformations in a model. The Metal Phase 
Transformation interface lets you generate a compound material whose properties are 
phase composition dependent. This material can be used by other physics interfaces, 
such as Solid Mechanics and Heat Transfer in Solids.

• Modeling Phase Transformations

• Metallurgical Phase Transformations
 2 :  M E T A L  P R O C E S S I N G  M O D E L I N G



Austenite Decomposition

The Austenite Decomposition interface is a specialized interface that considers 
hardening of steel from an austenitic state. During hardening of steels, the material is 
heated above the austenitizing temperature. It is then cooled, and depending on the 
rate of cooling, a combination of destination phases such as ferrite, pearlite, bainite, 
and martensite can form. The Austenite Decomposition interface automatically creates 
corresponding phase nodes and phase transformation nodes. You can also define an 
arbitrary number of additional phases and phase transformations. Optionally, you can 
define your own phase transformation models and let them coexist with other active 
phase transformations in the analysis. The Austenite Decomposition interface lets you 
generate a compound material whose properties are phase-composition dependent. 
This material can be used by other physics interfaces, such as Solid Mechanics and Heat 
Transfer in Solids.

Alpha–Beta Phase Transformation

The Alpha–Beta Phase Transformation interface is a specialized interface that is used 
to model phase transformations in α–β titanium alloys, such as Ti–6Al–4V. These 
alloys find uses in welding as well as additive manufacturing. In these applications, the 
material typically undergoes both heating and cooling, and depending on the rates at 
which this happens, different fractions of beta phase and alpha phases can form. The 
Alpha–Beta Phase Transformation interface automatically creates phase nodes and 
phase transformation nodes. In addition, transformation conditions are imposed the 
phase transformation nodes to, for example, restrict phase transformations to cooling 
or heating. The Alpha–Beta Phase Transformation interface lets you generate a 
compound material whose properties are phase-composition dependent. This material 
can be used by other physics interfaces, such as Solid Mechanics and Heat Transfer in 
Solids.

• Modeling Phase Transformations

• Metallurgical Phase Transformations

• Modeling Phase Transformations

• Metallurgical Phase Transformations
S E L E C T I N G  P H Y S I C S  I N T E R F A C E S  |  17
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Carburization

The Carburization interface provides a way to model the heat treatment process of 
carburization. The process involves placing a component in a carbon rich environment, 
at an elevated temperature. Over time, carbon is transferred into the surface of the 
component, and then progresses to the interior via diffusion. You can specify the 
carbon potential (the carbon concentration of the surrounding environment) as a 
function of time, to emulate a particular process. Or, you can use a simplified 
boost-diffuse carburization cycle that is provided by the interface. You can model the 
mass transfer of carbon into the surface of the component in different ways. You can 
prescribe the carbon concentration at the surface, or use a convective, thermally 
activated carbon mass transfer. Additionally, you can model selective carburization by 
prescribing zero carbon flux in certain regions of the component surface.
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S t u d y  T yp e s

Metallurgical Phase transformations are inherently time dependent. Phase 
transformations are defined by a set of ordinary differential equations in time. The 
Carburization interface solves the time-dependent diffusion of carbon in a component. 
The only supported study type for the Metal Processing physics interfaces is therefore 
Time Dependent.

In the COMSOL Multiphysics Reference Manual:

• Time-Dependent Solver

• Studies and Solvers
S T U D Y  T Y P E S  |  19
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Mode l i n g  Pha s e  T r a n s f o rma t i o n s

This section describes how to model metallurgical solid-solid phase transformations. 
When you simulate processes such as hardening of steel, these phase transformations 
are fundamental because they ultimately determine the final properties of the material. 
In the phase transformation interfaces, each phase transformation is defined by a 
certain evolution equation that defines the time rate of change of the algebraic 
proportion of a destination phase at the expense of a source phase. In the following, 
the two modeling concepts of phases and phase transformations are discussed.

Metallurgical Phases

When you model phase transformations in a material, each transformation defines how 
a source phase transforms into a destination phase as a function of time. When you 
create a metallurgical phase node, you have to define its initial phase fraction. This is 
the value from which the phase fraction evolves during the analysis.

You have the option, at the physics interface level, to compute effective thermal, 
electromagnetic, and mechanical properties for the compound material. If you have 
opted to do this, you also need to define the corresponding properties of each phase. 
At each phase node, you can choose to create a component-level phase material. This 
material can be populated with properties that define the behavior of the phase. As an 
alternative, you can use imported material properties. This is described in Importing 
Material Properties and Phase Transformation Data.

The phase material properties are averaged (phase-fraction averaged) into effective 
material properties of a compound material that can be used in other physics interfaces. 
This is described in Using Effective Material Properties.

Phase Transformations

When you have created a phase transformation node, you have to choose a source 
phase and a destination phase. These are the two phases that are fundamentally 
involved in the phase transformation. You also have the option of specifying additional 
source phases that contribute to the formation of the destination phase. The selected 
phase transformation model defines the underlying type of phase transformation. They 
are described below.
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T H E  L E B L O N D – D E V A U X  M O D E L

Phase transformations in steels are based on diffusion of carbon, and the Leblond–
Devaux phase transformation model is suitable to model this. You can choose between 
four formulations for the model — General coefficients, Time and equilibrium, TTT 

diagram data, and Parameterized TTT diagram. The first and second formulations 
require generally temperature-dependent functions that determine the characteristics 
of the phase transformation. The functions will be different for different phase 
transformations. The TTT diagram data formulation requires information that can be 
extracted from a TTT diagram, namely the time it takes at each temperature to reach 
a specified relative phase fraction. Typically, you would choose the transformation start 
line (for example, 1%). The Parameterized TTT diagram formulation is used to input 
three points from a TTT diagram, and let COMSOL Multiphysics construct a 
simplified TTT diagram using these points and additional curve shape parameters. The 
constructed TTT diagram is used internally to calculate the required parameters for the 
phase transformation model.

T H E  J O H N S O N – M E H L – A V R A M I – K O L M O G O R O V  ( J M A K )  M O D E L

You can choose between five formulations for the model — Time, equilibrium, and 

exponent; TTT diagram data; TTT diagram data, fixed exponent; Parameterized TTT 

diagram; and Parameterized TTT diagram, fixed exponent. The first formulation can be 
viewed as a generalization of the Time and equilibrium form of the Leblond–Devaux 
model. In addition to the generally time-dependent functions describing the 
equilibrium phase fraction and the time constant, a time-dependent exponent is used. 
The exponent is called the Avrami exponent, and it alters the characteristic of the phase 
transformation. The TTT diagram data and TTT diagram data, fixed exponent 

formulations require information that can be extracted from the curves in a TTT 
diagram, namely the time it takes at each temperature to reach a specified relative phase 
fraction. The former requires two times to calculate the time constant and the Avrami 
exponent, at two respective relative phase fractions. These can represent, for example 
the transformation start (for example, 1%) and finish (for example, 90%) times, at each 
temperature. The TTT diagram data, fixed exponent formulation requires that you 
specify the Avrami exponent separately, and then use a single transformation time, such 
as the transformation start. The Parameterized TTT diagram and Parameterized TTT 

diagram, fixed exponent formulations are used to input points from a TTT diagram, and 

The Leblond–Devaux Model
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let COMSOL Multiphysics construct a simplified TTT diagram using these points and 
additional curve shape parameters. The constructed TTT diagram is used internally to 
calculate the required parameters of the phase transformation model. In the former, 
two TTT curves are used. These can represent, for example, the start and finish curves 
of the transformation. In the latter, a single TTT curve is used to internally calculate 
the time constant, and the Avrami exponent is specified separately.

T H E  K I R K A L D Y – V E N U G O P A L A N  M O D E L

This phase transformation model is suitable for diffusion-based phase transformations, 
such as occur in steels during quenching. You can choose between three formulations 
for the model — Rate coefficient, TTT diagram data, and Parameterized TTT diagram. The 
first formulation requires a rate coefficient that represents a lumped effect of 
temperature and chemical composition on the rate equation for the phase 
transformation. The TTT diagram data formulation requires information that can be 
extracted from a TTT diagram, namely the time it takes at each temperature to reach 
a given relative phase fraction. This information is then used internally to calculate the 
required parameters for the phase transformation model. The Parameterized TTT 

diagram formulation is used to input three points from a TTT diagram, and let 
COMSOL Multiphysics construct a simplified TTT diagram using these points and 
additional curve shape parameters. The constructed TTT diagram is used internally to 
calculate the required parameters for the phase transformation model.

T H E  K O I S T I N E N – M A R B U R G E R  M O D E L

This phase transformation model is suitable to model the displacive martensitic 
transformation in steel, on rapid cooling. You can choose between two formulations 
for the model — Koistinen-Marburger coefficient and Martensite finish temperature. In 
the first formulation, you specify the Martensite start temperature Ms and the 
Koistinen–Marburger coefficient β. The martensite start temperature defines the onset of 
the phase transformation, and the Koistinen–Marburger coefficient defines how 
rapidly the phase transformation progresses as the temperature decreases. The 
martensite start temperature Ms can be experimentally obtained from dilatometry 

The Johnson–Mehl–Avrami–Kolmogorov (JMAK) Model

The Kirkaldy–Venugopalan Model
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experiments. If the integrated form of the phase transformation model is used 
(Equation 3-22), a value for the Koistinen-Marburger coefficient β can be correlated to 
the temperature at which the martensitic transformation is considered complete (see, 
for example, Ref. 8). In the second formulation, the phase transformation is defined 
by the Martensite start temperature Ms and the Martensite finish temperature M90. The 
latter is the temperature corresponding to 90% martensite formation, using the 
integrated form of the phase transformation model. 

T H E  H Y P E R B O L I C  R A T E  M O D E L

This phase transformation model can be used for example to model dissolution of α 
phase in titanium, on heating. The model assumes that the rate of formation of the 
destination phase is inversely proportional to the phase fraction of the destination 
phase.

Calibration of Phase Transformation Models

During a thermal transient, a material point may undergo varying rates of cooling and 
heating. During this transient, several phase transformations can be active at the same 
time. This suggests that it is difficult to calibrate phase transformation models 
individually, as they tend to affect one another. For example, in the case of austenite 
decomposition, it is common in practice to present the complicated nature of phase 
transformations as continuous cooling transformation (CCT) or time-temperature 
transformation (TTT) diagrams; see Figure 2-1 and Figure 2-2 for schematic 
examples. Both diagrams show the start temperatures for the formation of a small 
fraction of different phases (Fs for the start temperature of ferrite, and so on). The 

The Koistinen–Marburger Model

For an example how to model phase transformations, see Phase 
Transformations in a Round Bar: Application Library path 
Metal_Processing_Module/Tutorial_Examples/phase_transformations_in_a_ro

und_bar.
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fraction can be chosen arbitrarily but is often 0.1% or 1%. The difference between the 
two diagram types, as their names imply, is the following:

• A CCT diagram is constructed by performing experiments where a small specimen 
is cooled at a specified, constant, temperature rate.

• A TTT diagram is constructed by performing experiments where a small specimen 
is rapidly cooled to a temperature T0 that is subsequently kept constant.

One method to measure the actual start temperatures required to draw each diagram 
is to use dilatometry experiments. Metallurgical phase transformations are 
accompanied by a change in volume, owing to the density difference between phases. 
In a dilatometer, a specimen is cooled (or heated), and its length is monitored. The 
specimen length will change according to basic thermal expansion, but phase 
transformations will induce additional length changes that can be measured.

In a real quenching situation, it is clear that material points do not experience either of 
the two extremes represented by the CCT and TTT diagrams (constant temperature 
rate versus constant temperature). Nevertheless, because experimentally obtained 
CCT and TTT diagrams are very common in the heat treatment community, phase 
transformation models must in practice be calibrated using them.

It is here useful to examine one formulation of the Leblond–Devaux model:

In this equation, the phase fraction for the destination phase tends toward an 
equilibrium value , and the rate at which this occurs is characterized by the time 
constant . Note here that the equilibrium phase fraction and the time constant 
are in general both temperature dependent, and that temperature in turn varies with 
time. At constant temperature, the equation can be integrated analytically, giving

The equilibrium phase fraction can be deduced from an (equilibrium) iron-carbon 
diagram (Ref. 1) or from dilatometry experiments at a very low temperature rate (or 
at constant temperature after a rapid temperature drop). If we know this equilibrium 
phase fraction at a given temperature t1, we can compute the temperature dependent 
time constant from knowing the time it takes to reach a specific phase fraction 
(isothermally):

ξ·
d ξeq

d ξd
–

τs d→
--------------------=

ξeq
d

τs d→

ξd ξeq
d 1 t

τs d→
--------------– 

 exp– 
 =
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Alternatively, if we know the time to reach, for example, 1% of the equilibrium phase 
fraction, that is, the relative phase fraction

the time constant is obtained without knowing the equilibrium phase fraction. Thus, 
a TTT diagram showing curves of transformation times corresponding to relative 
phase fractions X can straightforwardly be used to compute the temperature 
dependent time constant. In this sense, a TTT diagram is easier to use for phase 
transformation model calibration than a CCT diagram. This method to the calibration 
of phase transformation models to TTT diagram data can be used also for the 
Johnson–Mehl–Avrami–Kolmogorov (JMAK) and Kirkaldy–Venugopalan models. It 
should be pointed out that given a set of phase transformation model parameters, it is 
straightforward to compute both types of diagrams and to adjust the model parameters 
based on comparisons of the computed diagrams and experimental information. It is 
sometimes necessary to iterate in this manner to find a sufficiently accurate set of 
model parameters.

As a final alternative to performing the calibration using TTT or CCT diagrams, you 
can import computed phase transformation data. This is described in Importing 
Material Properties and Phase Transformation Data.

τs d→
t1

1 ξd

ξeq
d
--------–

 
 
 

ln

------------------------------–=

X ξd

ξeq
d
--------=
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Figure 2-1: A CCT diagram showing how phases appear during cooling at two different 
rates. The temperatures corresponding to 1% formed fraction of ferrite, pearlite, and 
bainite are shown. The martensite start temperature is shown as a straight line. The time 
is shown on a logarithmic axis.
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Figure 2-2: A TTT diagram showing how the temperature is rapidly decreased to a fixed 
value T0 and then kept constant.

For an example how to compute CCT and TTT diagrams, see 
Transformation Diagram Computation: Application Library path 
Metal_Processing_Module/Transformation_Diagrams/transformation_diagram

_computation.

For an example how to calibrate a phase transformation model based on 
experimental TTT diagram data, see Transformation Diagram 
Computation: Application Library path 
Metal_Processing_Module/Transformation_Diagrams/calibration_against_ttt_

data.
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De f i n i n g  Mu l t i p h y s i c s  Mode l s

This chapter describes how two couple the phase transformation interfaces to the Heat 
Transfer in Solids and Solid Mechanics interfaces. A good place to start reading is in 
Building a COMSOL Multiphysics Model in the COMSOL Multiphysics Reference 
Manual. 

In this chapter:

• Heat Transfer with Phase Transformations — For modeling phase transformations 
coupled to heat transfer.

• Steel Quenching — For modeling the specific case of austenite decomposition 
coupled to heat transfer and solid mechanics.

• Phase Transformation Latent Heat — A predefined unidirectional coupling that 
adds latent heat from phase transformations as a heat source term in the coupled 
heat transfer interface.

• Phase Transformation Strain — A predefined bidirectional coupling that is used to 
transfer strains and stresses to, and from, the coupled solid mechanics interface.

Heat Transfer with Phase Transformations

The Heat Transfer with Phase Transformations multiphysics interface combines the 
Metal Phase Transformation interface with the Heat Transfer in Solids interface. Phase 
transformations are generally temperature dependent, and this interface is a suitable 
starting point for modeling metallurgical phase transformations that occur during a 
thermal transient. Latent heat is generated during phase transformations, and the 
interface transfers this generated heat to the heat equation that is used by the Heat 
Transfer in Solids interface, as shown in Figure 2-3. This is done using the Phase 
Transformation Latent Heat multiphysics coupling.

Figure 2-3: The constituent interfaces of the Heat Transfer with Phase Transformations 
interface.
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Steel Quenching

The Steel Quenching multiphysics interface combines the Austenite Decomposition 
interface with the Heat Transfer in Solids and the Solid Mechanics interfaces. This is 
the most specialized interface of the Metal Processing Module. It can be used to study 
heat treatment processes by which steel parts, which have been heated to a fully 
austenitic state, are quenched. The multiphysics interface couples the constituent 
interfaces so that effects of latent heat and phase transformation strains can be included 
in the analysis. Phase compositions, distortions, and residual stresses can be computed 
using the Steel Quenching multiphysics interface. Figure 2-4 shows how this 
information is passed to, and from, the Austenite Decomposition interface. Note that, 
for example, material properties used in Solid Mechanics can be temperature 
dependent, and that plastic dissipation can act as a heat source in Heat Transfer in 
Solids (this is not shown in Figure 2-4). The Steel Quenching multiphysics interface 
uses the Phase Transformation Latent Heat multiphysics coupling and the Phase 
Transformation Strain multiphysics coupling. 

Figure 2-4: The constituent interfaces of the Steel Quenching interface.

For an example how to use the Steel Quenching interface, see 
Carburization and Quenching of a Steel Gear: Application Library path 
Metal_Processing_Module/Steel_Quenching/carburization_and_quenching_of_

a_steel_gear.
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Phase Transformation Latent Heat

This unidirectional multiphysics coupling generates a heat source term in the heat 
equation of the coupled Heat Transfer in Solids interface. The heat source term 
corresponds to the latent heat produced during phase transformations.

Phase Transformation Strain

This bidirectional multiphysics coupling is used to transfer strains and stresses to, and 
from, the coupled Solid Mechanics interface.

• If Enable transformation-induced plasticity is selected, the stress tensor from the Solid 
Mechanics interface is used to compute TRIP strains during phase transformations. 
These strains are used by the Solid Mechanics interface as an inelastic strain 
contribution.

• If Enable thermal strains is selected, the thermal strains are used by the Solid 
Mechanics interface as an inelastic contribution.

• If Enable phase plasticity is selected, and if the Plasticity subnode under Linear Elastic 

Material is used by the coupled Solid Mechanics interface, the equivalent plastic 
strain is transferred to the phase transformation interface. This way, the individual 
hardening function for each phase can be evaluated.

See Phase Transformation Latent Heat in the theory chapter.

When you use this coupling, you should not use the Thermal Expansion 
node to compute thermal strains to be used in the Solid Mechanics 
interface.
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Annealing

An Annealing subnode can be added to the Phase Transformation Strain multiphysics 
coupling. This subnode is used to specify an annealing temperature above which plastic 
hardening variables (equivalent plastic strains) are set to zero.

• The Annealing multiphysics subnode must be used in conjunction with the Annealing 
subnode to Plasticity in the coupled Solid Mechanics interface, operating on the 
same selection.

• TRIP strains, thermal strains, and the plastic strain tensor are unaffected by the 
Annealing subnode.
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S e l e c t i n g  D i s c r e t i z a t i o n

Phase Transformation Modeling

The Metal Phase Transformation, Austenite Decomposition, and Alpha-Beta Phase 
Transformation interfaces provide a Discretization for phase fractions setting. This is 
used to set the shape function order for the phase fractions, and it should match the 
settings for the temperature field used by the Heat Transfer in Solids interface. It is set 
to quadratic by default, to match the default setting of the Heat Transfer in Solids 
interface.

Carburization Modeling

The discretization setting for Carburization interface controls the shape function order 
for the carbon concentration. The Element order is set to quadratic by default.
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U s i n g  E f f e c t i v e  Ma t e r i a l  P r op e r t i e s

When a material undergoes phase transformations during a thermal transient, its 
material properties will change. The properties are typically temperature dependent 
and tend to be phase dependent, too. For example, the initial yield stress at a given 
temperature will be higher in martensite than in ferrite — two metallurgical phases that 
appear during hardening of steel. When the Metal Phase Transformation, Austenite 
Decomposition, or Alpha-Beta Phase Transformation interface is used with Heat 
Transfer in Solids or Solid Mechanics, it can compute effective material properties that 
can be utilized by these interfaces. The benefit is that the Heat Transfer in Solids and 
Solid Mechanics interfaces themselves do not need to perform phase averaging of the 
material properties that are used.

You can generate a compound material that can be used by other physics interfaces as 
a domain material. The compound material is created if you use the Create Compound 

Material option at the physics interface level. This material contains effective material 
properties that are computed from the corresponding material properties defined for 
each phase.

Compound Material Properties

Note that if Enable phase plasticity has been selected at the physics 
interface level, the User defined option should be used for the Isotropic 

hardening model in the Plasticity node in Solid Mechanics.
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Impo r t i n g  Ma t e r i a l  P r op e r t i e s  and 
Pha s e  T r a n s f o rma t i o n  Da t a

When the Metal Phase Transformation, Austenite Decomposition, or Alpha-Beta 
Phase Transformation interface is used, parameters for the different phase 
transformations have to be defined. Additionally, if the interface is used with Heat 
Transfer in Solids or Solid Mechanics, the material properties of the metallurgical 
phases have to be defined. Phase transformations and material properties are typically 
temperature dependent. In the case of plasticity, the material properties also depend 
on plastic strain and plastic strain rate.

The effort involved in obtaining material properties and phase transformation data 
experimentally, or by consulting literature sources, can be time consuming and 
expensive. As an alternative, material properties and phase transformation data for 
general steels can be imported from the software JMatPro®. The following sections 
describe how this is done.

Material Properties

When you import material properties, one material is created for each of the 
metallurgical phases austenite, ferrite, pearlite, bainite, and martensite. These materials 
can then be used as Phase Material in the Metallurgical Phase nodes in the Metal Phase 
Transformation, Austenite Decomposition, and Alpha-Beta Phase Transformation 
interfaces. In addition to material properties for the individual metallurgical phases, 
effective material properties that represent a compound material behavior are collected 
and imported into a separate material. This material can be merged into, for example, 
a created compound material, see Using Effective Material Properties.

To merge a material with effective properties into a compound material, 
use either Merge Into from the context menu, or use the Merge Into menu 
in the Materials toolbar. See Merging a Material Into Another Material for 
details.
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L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menu
With Global Definitions or a Component selected:

Materials>Import

Phase Transformation Data

When you import phase transformation data, one phase transformation node is created 
for each of the phase transformations involved in the decomposition of austenite:

• austenite to ferrite

• austenite to pearlite

• austenite to bainite

• austenite to martensite

In addition to data that describe the phase transformation kinetics, other data is 
imported and added to each phase transformation node. They are:

• phase transformation latent heat

• the parameter for transformation induced plasticity (TRIP)

The import can be performed under the Metal Phase Transformation, Austenite 

Decomposition, and Alpha-Beta Phase Transformation interfaces, although the Austenite 

Decomposition interface is the natural interface to perform the import from.

L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menu
With Metal Phase Transformation or Austenite Decomposition interface selected:

Import Phase Transformations

Note that you need to manually select the source phase and destination 
phase that participate in each imported phase transformation.
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Mode l i n g  C a r bu r i z a t i o n

This section describes how to model the heat treatment process of carburization. The 
process typically involves placing a component in a carbon rich environment, and 
letting carbon diffuse into the component over time. When you use the Carburization 
interface, you need to specify the characteristics of the surrounding carburization 
environment, specify the way in which carbon can move across the component surface, 
and finally specify how carbon is able to diffuse internally in the component. This is 
described below.

Defining a Carburization Environment

When you use the Carburization interface, you can define the carbon concentration of 
the environment surrounding the component to be carburized. This is done by 
selecting the type of Carburizing Cycle. You can either specify the carbon concentration 
directly, as a function of time, or you can use the built-in Boost-diffuse cycle. In the 
latter situation, you use a simple cycle where the carbon potential cpot is at a high value 
for an initial time ( ), and after this boost period, the carbon potential is 
lowered, and the diffuse stage begins.

Modeling Carbon Diffusion

The diffusion of carbon into a component is modeled using Fick’s second law of 
diffusion. When you solve the carbon diffusion problem, you need to specify the initial 
carbon concentration in the component using the Initial Values node. You then need 
to define the diffusion coefficient to be used in the diffusion equation. This diffusion 
coefficient can either be specified as an expression, or specified using a provided 
thermally activated (Arrhenius type) form.

t tboost≤

See Carbon Potential Model in the theory chapter.

See Carburization in the theory chapter.
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Boundary Conditions

You can model the exchange of carbon with the surrounding environment in different 
ways. You can apply two types boundary conditions to model the carbon mass transfer. 
They are of Dirichlet (prescribed carbon concentration) or of Neumann (prescribed 
carbon flux) types. In the case of a prescribed carbon flux, you have the option of using 
a thermally activated (Arrhenius type) description for the carbon mass transfer 
coefficient. By default, the external surfaces of a component have zero flux, which 
means that they do not transfer any carbon from or to the surrounding environment. 
The zero flux boundary conditions are replaced by the boundary conditions discussed 
previously. In a situation where you model selective carburization, you may want to 
leave parts of the external component surface with a zero carbon flux condition, as this 
would correspond to partially masking the surface from the surrounding environment.

See Boundary Conditions in the theory chapter.
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M e t a l  P r o c e s s i n g  T h e o r y
This chapter introduces you to the theory for the Metal Processing Module.

In this chapter:

• Metallurgical Phase Transformations

• Phase Transformation Strains

• Phase Transformation Latent Heat

• Compound Material Properties

• Carburization
 39
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Me t a l  Pha s e  T r a n s f o rma t i o n  Th eo r y

In the following, the theory for the Metal Phase Transformation physics interface is 
described. This section also covers the theory for the Austenite Decomposition physics 
interface. These physics interfaces can be used to model metallurgical phase 
transformations in metals. They can be coupled to Heat Transfer in Solids and Solid 
Mechanics, where, for example, quenching of steel components can be performed.
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Me t a l l u r g i c a l  Pha s e  T r a n s f o rma t i o n s

Definitions

The material consists of a number of metallurgical phases. The fraction of each phase 
i is denoted ξi. There are in general N phases, where

The initial phase fraction must be defined for each phase, and the sum of initial phase 
fractions should be one. At the onset of an analysis, some phases may not be present, 
and have zero initial phase fraction.

Each phase transformation describes how a source phase s transforms into a 
destination phase d. A phase transformation is formally defined by the rate at 
which the destination phase d forms at the expense of the source phase s. This can be 
expressed as

 (3-1)

Note that this equation describes only a single contribution to the total rates at which 
the destination phase forms, and the source phase decomposes. With several 
simultaneous phase transformations, some phases may receive more than one 
contribution. As an example, consider the case of three phases and two phase 
transformations, where phase 1 transforms into phases 2 and 3. Using the terminology 
above, the total rate equations for the three phases can be expressed as

ξi

i 1=

N

 1=

• The phase fractions are defined in the material frame.

• Because of the employed weighting scheme for the effective mass 
density of the compound material, the phase fractions become 
algebraic fractions.

• See Compound Material Properties.

As d→

As d→ ξ·
d

ξ·
s

–= =

ξ·
1

A– 1 2→ A1 3→–=
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Note that these rate equations satisfy

In COMSOL Multiphysics, a weak contribution is generated for each phase i:

where the summation is done over every phase transformation for which phase j 
transforms into phase i.

In some situations, you may want to lump several phase transformations into one, so 
that several source phases decompose using the same phase transformation kinetics. 
One example is a simplified description of austenitization, if you are not concerned 
with the exact order in which phases like martensite and pearlite transform into 
austenite. Here, the destination phase is taken to form according to

The negative of this rate is taken to be the sum of the rates of the (now several) source 
phases so that

where the summation is taken over the participating source phases. The contribution 
of each source phase to the total rate is arbitrary, and a modeling decision has to be 
made with regard to this indeterminacy. In COMSOL Multiphysics, the use of 
multiple source phases in a phase transformation is handled by assuming that each 
source phase rate is proportional to  through its own current phase fraction 
divided by the phase fraction sum of all participating source phases. For each source 
phase, the rate contribution is therefore

ξ·
2

A1 2→=

ξ·
3

A1 3→=

ξ·
i

i 1=

N

 0=

ξ·
i

Aj i→
j
–

 
 
 

δξi

ξ·
d

As d→=

A– s d→ ξ·
j

j
=

A– s d→
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 (3-2)

By using Equation 3-2, the correct sum of the source phase rates is ensured, and the 
indeterminacy of their respective contributions is eliminated. Moreover, Equation 3-2 
reduces to the standard form given by Equation 3-1 in the case of a single source 
phase.

Phase Transformation Models

In this section, the different types of phase transformations are described.

T H E  L E B L O N D –D E V A U X  M O D E L

This phase transformation model is based on the work of Leblond and Devaux 
(Ref. 1). The model primarily considers carbon-diffusion-based phase transformations 
that occur in steels during heat treatment. Such transformations include austenite to 
ferrite, and austenite to bainite. There are four formulations for the Leblond–Devaux 
model:

• General coefficients

• Time and equilibrium

• TTT diagram data

• Parameterized TTT diagram

General coefficients
Using this form, the transformation of a source phase into a destination phase is given 
by

 (3-3)

where the phase transformation is active only when ; that is, when the 
right-hand side of Equation 3-3 is strictly positive. In general, the functions  
and  are functions of temperature T. It was shown in Ref. 1 that the bainitic 
transformation additionally depends on the rate of cooling, . In this case, the 
functions  and  are functions of both T and .

ξ·
s

ξs 
As d→

ξj

j

----------------–=

ξ·
d

Ks d→ ξs Ls d→ ξd
–=

ξ·
d

0>
Ks d→

Ls d→
T·

Ks d→ Ls d→ T·
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Time and Equilibrium
This form is a special case of the general-coefficients form. The phase transformation 
is defined by an equilibrium phase fraction for the destination phase and a time 
constant . The phase transformation is given by

 (3-4)

where the phase transformation is active only when ; that is, when the right side 
of Equation 3-4 is strictly positive. The equilibrium phase fraction  and the time 
constant  are typically functions of temperature.

TTT Diagram Data
At constant temperature, the time-temperature formulation of the Leblond–Devaux 
phase transformation model can be integrated analytically:

 (3-5)

where  is the initial phase fraction. This enables straightforward calibration of the 
model parameters from TTT diagram data. At a given temperature, and assuming that 
the initial phase fraction is zero, the equilibrium phase fraction of the destination phase 
is . A relative phase fraction of the destination phase is defined such that it is 1.0 
as the equilibrium phase fraction is reached. The relative phase fraction X is given by

 (3-6)

In the TTT diagram in Figure 3-1, a curve representing a fixed destination phase 
fraction  is shown. At a fixed temperature T, this destination phase fraction is 
reached at time t1, so that

 (3-7)

The characteristic time is then expressed as

 (3-8)

where t1 will vary with temperature, and the relative phase fraction X1 is understood 
to be the relative phase fraction corresponding to .
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d
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Figure 3-1: Constant phase fraction curve in a TTT diagram.

This way of fitting the Leblond–Devaux model to TTT diagram data will be most 
accurate near the chosen phase fraction curve in the TTT diagram. If, for example, the 
0.1% curve is used, the phase transformation model will likely predict the onset of 
destination phase formation well, but it will show poorer agreement with the TTT 
diagram near completion.

Parameterized TTT Diagram
The Leblond–Devaux model can use a parameterized TTT diagram as input, in which 
a single TTT curve is used to identify the time constant. See Parameterized TTT 
Diagram.

T H E  J O H N S O N – M E H L – A V R A M I – K O L M O G O R O V  ( J M A K )  M O D E L

This phase transformation model is based on the work by Leblond and others (Ref. 3). 

There are five formulations for the JMAK model:

• Time, equilibrium, and exponent

• TTT diagram data

• TTT diagram data, fixed exponent

• Parameterized TTT diagram

• Parameterized TTT diagram, fixed exponent
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Time, Equilibrium, and Exponent
The first formulation can be viewed as a generalization of the time-temperature 
formulation for the Leblond–Devaux model. It is based on an Avrami law of the form

 (3-9)

In the equation above, the initial phase fraction is , and the equilibrium phase 
fraction , the time constant  and the Avrami exponent  are typically 
functions of temperature. On rate form, Equation 3-9 can be expressed as

 (3-10)

where the explicit time dependence has been eliminated. The phase transformation is 
active only when ; that is, when the right side of Equation 3-10 is strictly 
positive. For the special case of , the equation reduces to the 
time-and-equilibrium form of the Leblond–Devaux model (Equation 3-4). The 
JMAK phase transformation model in Equation 3-10 has a mathematical disadvantage 
in that an initial destination phase fraction equal to zero will yield a trivial zero 
solution, as the logarithm will evaluate to zero. There are different ways to circumvent 
this problem. One way is to require the initial phase fraction be assigned a small, but 
finite, value. Another way is to modify the rate equation itself, so that a zero initial 
phase fraction does not yield a trivial zero solution. In the phase transformation 
interfaces, the JMAK phase transformation model in Equation 3-10 is modified for 
phase fractions  in the vicinity of . Below a certain threshold, the argument for 
the logarithm is modified so that the logarithm does not produce a zero value. This 
threshold phase fraction is set to 10-5 by default. A problem can arise in the case of 
nonzero initial phase fractions. Namely, if other phase transformations in the model 
operate such that the metallurgical phase that is the destination phase fraction above 
decreases, the JMAK model would run into problems as , whereby the 
argument in the logarithm becomes negative. One way to handle this is to exclude the 
effect of the initial phase fraction in the rate expression in Equation 3-10. This is done 
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in COMSOL Multiphysics. A judgment has to be made in each situation whether this 
is a proper modeling assumption.

TTT Diagram Data
As in the case of the Leblond–Devaux model, the JMAK model can be calibrated using 
TTT diagram data. The integrated form in Equation 3-9 is used to calibrate the time 
constant  and the Avrami exponent . To calibrate these two phase 
transformation model parameters, two curves are needed from a TTT diagram; see 
Figure 3-2. As for the Leblond–Devaux model, a zero initial phase fraction is assumed 
when calibrating the JMAK model. At a fixed temperature T, the two destination phase 
fractions are reached at times t1 and t2, respectively, so that

 (3-11)

 (3-12)

After some algebra, the time constant and Avrami exponent can be expressed as

 (3-13)

 (3-14)

where the relative phase fractions X1 and X2 are understood to be the relative phase 
fractions corresponding to  and , respectively. The transformation times t1 and 
t2 will vary with temperature.

The phase fraction threshold variable used by the JMAK phase 
transformation model can be modified in the Equation View of the Phase 

Transformation node. Typically, the default value of 10−5 should not have 
to be changed.

Note that the Avrami exponent used by the JMAK phase transformation 
model should be greater than or equal to one. If a smaller value is 
encountered, it will be replaced by an exponent of one.
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Parameterized TTT Diagram
The JMAK model can use a parameterized TTT diagram as input, in which two TTT 
curves are used to identify the time constant and the Avrami exponent. See 
Parameterized TTT Diagram.

Parameterized TTT Diagram, Fixed Exponent
The JMAK model can use a parameterized TTT diagram as input, in which a single 
TTT curve is used to identify the time constant. Using this formulation, you specify 
the Avrami exponent separately. See Parameterized TTT Diagram.

Figure 3-2: Constant phase fraction curves in a TTT diagram.

T H E  K I R K A L D Y – V E N U G O P A L A N  M O D E L

This phase transformation model is based on the work by Kirkaldy and Venugopalan 
(Ref. 10), and extended and modified by several others. There are two formulations 
for the Kirkaldy–Venugopalan phase transformation model:

• Rate coefficient

• TTT diagram data

• Parameterized TTT diagram

Rate Coefficient
The rate form describing the phase transformation model is given by

 (3-15)ξ·
d

ξeq
d ξ·0

dX

2 1 X–( )
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2X
3
--------

CrX2( )exp
-----------------------------------------------=
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where  is the equilibrium phase fraction;  is a reference rate that in principle 
depends on temperature, chemical composition, and grain size; and Cr is a retardation 
coefficient. The relative phase fraction X is defined as

 (3-16)

so that the rate of formation of the destination phase approaches zero as the relative 
phase fraction approaches one; that is, when the phase transformation nears 
completion. The Kirkaldy–Venugopalan phase transformation model shares the 
mathematical disadvantage with the JMAK model in that an initial destination phase 
fraction of zero will yield a trivial zero solution. Similar to the JMAK phase 
transformation model, the Kirkaldy–Venugopalan phase transformation model is 
modified. A small threshold value for the destination phase fraction ξd is introduced, 
so that the phase transformation model produces a nonzero rate below this value.

TTT Diagram Data
The Kirkaldy–Venugopalan phase transformation model can be calibrated using TTT 
diagram data. Similar to the cases of the Leblond–Devaux and JMAK phase 
transformation models, the expression for the rate of destination phase formation is 
used to identify the model parameters, here the rate coefficient . Rearranging the 
rate expression in Equation 3-15 gives an expression of the form

 (3-17)

where the relative phase fraction X has been used. Note that at a fixed temperature, the 
equilibrium phase fraction is constant, and it can therefore be included in the rate 
term  in Equation 3-17. The reference rate  is temperature dependent (and 
dependent on chemical composition and grain size, in the original Kirkaldy–
Venugopalan formulation). At a fixed temperature, t1 is the time to reach the 
destination phase fraction  (or alternatively, to reach the relative phase fraction X1), 
see Figure 3-3. This is expressed as

ξeq
d ξ·0

d

X ξd

ξeq
d
--------=

The phase fraction threshold variable used by the Kirkaldy–Venugopalan 
phase transformation model can be modified in the Equation View of the 
Phase Transformation node. Typically, the default value of 10−5 should not 
have to be changed.
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M E T A L L U R G I C A L  P H A S E  T R A N S F O R M A T I O N S  |  49



50 |  C H A P T E R
 (3-18)

 (3-19)

Figure 3-3: Constant phase fraction curve in a TTT diagram.

Using Equation 3-17, the rate coefficient is expressed as

 (3-20)

Note that if the retardation coefficient Cr is known, the integral can be computed a 
priori for a fixed X1. The rate coefficient is therefore inversely proportional to the time 
it takes to reach the relative phase fraction X1. The time t1 generally depends on 
temperature.

Parameterized TTT Diagram
The Kirkaldy–Venugopalan model can use a parameterized TTT diagram as input, in 
which a single TTT curve is used to identify the rate coefficient. See Parameterized 
TTT Diagram.
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T H E  K O I S T I N E N – M A R B U R G E R  M O D E L

This phase transformation model was developed by Koistinen and Marburger (Ref. 2) 
to model the diffusionless (displacive) austenite to martensite transformation in 
iron-carbon alloys and carbon steels. The onset of the transformation, which only 
occurs on cooling, is characterized by a critical start temperature — the martensite start 
temperature Ms. Above this temperature, no transformation from austenite (the 
source phase) to martensite (the destination phase) occurs. Below Ms, the amount of 
formed martensite is proportional to the undercooling below Ms, given by Ms − T. On 
rate form, the Koistinen–Marburger equation can be written

 (3-21)

where β is the Koistinen–Marburger coefficient. Note that the transformation of 
austenite into martensite only occurs below Ms and only during cooling (that is, when 

). To make the onset of martensitic transformation numerically smooth, a 
parameter ΔMs is used. The smoothing parameter defines a smoothed Heaviside 
function that makes the onset of martensitic transformation gradual. The parameter 
should be chosen small enough that the start temperature characteristic is retained. 
Assuming a constant cooling rate and that the phase fraction of austenite at Ms is , 
the rate equation can be integrated to

 (3-22)

This integrated form is commonly found in the literature. Instead of defining the 
Koistinen–Marburger coefficient directly, a martensite finish temperature, M90, can be 
defined, corresponding to reaching a phase fraction of 90% using Equation 3-22, and 
assuming 100% initial source phase fraction. The Koistinen–Marburger coefficient β is 
then given by

The rate form of Equation 3-21 is more general, and from a computational standpoint 
it is more suitable for implementation. The rate form is therefore used in the phase 
transformation interfaces.

U S E R  D E F I N E D

Using this option, other types of phase transformations can be defined. A user-defined 
phase transformation assumes that a source phase decomposes into a destination phase 
according to Equation 3-1.
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-------------------------–=
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Parameterized TTT Diagram

A curve in a TTT diagram represents the time it takes to form a certain relative phase 
fraction of a metallurgical phase, under isothermal conditions. Using experimental 
TTT diagram data, one can extract transformations times across a range of 
temperatures and thereby characterize temperature dependent phase transformations. 
This is what you typically need to do for the TTT Diagram Data formulations of the 
Leblond–Devaux, the JMAK, and the Kirkaldy–Venugopalan phase transformation 
models. In some situations, it may be sufficient to approximate the shape of a TTT 
curve using analytical functions. COMSOL Multiphysics provides a functionality to 
enter three characteristic time-temperature points on a TTT curve, and together with 
two shape parameters, construct an approximate a TTT curve. The three points that 
are used to define the TTT curve in this way are:

• A point on the upper part of the curve

• A point on the lower part of the curve

• The point defining the “nose” of the curve

The points are designated U (upper), L (lower), and N (nose), see Figure 3-4.

Figure 3-4: A parameterized TTT curve.

The parameterized TTT curve is defined by two analytical functions that meet at the 
nose. They are:

, t
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, 

The shape parameters qNL and qNU are used to control the shape of the curve below 
the nose (NL) and above the nose (NU), and the effect of increasing them is 
schematically shown in Figure 3-4. A shape parameter value of two produces a 
quadratic function in the log time - temperature space, and so on. When you 
parameterize the curves in a TTT diagram in this way, COMSOL Multiphysics will 
internally use the TTT curves in the same way as if you had used the TTT Diagram 
Data formulations.

Transformation Temperatures

For hypoeutectoid steels that are being cooled from an austenitic state, the phase 
transformations into different destination phases occur across certain temperature 
ranges. For example, no ferrite forms before the temperature falls below the Ae3 
temperature in an Fe–C diagram, as austenite is stable above this temperature. Another 
example is the (eutectoid) Ae1 temperature above which no pearlite forms. These 
temperatures, and other temperatures that are important when modeling phase 
transformations in steels, depend not only on the carbon content of the material, but 
also on other alloying elements. There exist several empirical models in the literature, 
and COMSOL Multiphysics provides several of these temperatures through the Steel 
Composition node that can be used in the Metal Phase Transformation and Austenite 
Decomposition interfaces. The temperatures can be readily accessed by the Phase 

Transformation nodes to facilitate phase transformation modeling.

T H E  A E 1  A N D  A E 3  T E M P E R A T U R E S

In an Fe–C diagram, the Ae1 and Ae3 temperature lines represent the lower and upper 
limits of the two-phase ferrite–austenite region. For a steel of a given carbon content, 
the Ae3 temperature can be viewed as a ferrite start temperature, that is, the upper 
temperature for ferrite formation when cooling the steel from the purely austenitic 
state. Similarly, the Ae1 temperature can be viewed as the pearlite start temperature, 
see Figure 3-5.

t
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Figure 3-5: A schematic Fe–C diagram. The ferrite–austenite two-phase region is 
indicated in gray.

Andrews (Ref. 11) developed empirical models for these temperatures, based on the 
alloying elements of the material. The models are given by

where C, Si, Ni, and so forth, are the weight percentages of the respective alloying 
elements. These expressions are valid for steels with a carbon concentration less than 
0.6% by weight. As an alternative to using the models by Andrews, you can use a 
parameterized description of the Ae1 and Ae3 temperature lines. To do this, you specify 
directly the Ae3 temperature at zero carbon concentration, , the Ae1 temperature, 
and the eutectoid concentration of austenite, . This gives the following linear 
expression for the Ae3 temperature line:

Ae1 °C( ) 723 16.9Ni– 29.1Si 6.38W 10.7Mn– 16.9Cr 290As+ + + +=

Ae3 °C( ) = 910 203 C– 44.7Si 15.2Ni– 31.5Mo 104V 13.1W –+ + + +

30Mn 11Cr 20Cu 700P– 400Al– 120As– 400Ti–+ +

Ae3
0

Ceut
γ

Ae3 Ae3
0 Ae3

0 Ae1–

Ceut
γ

------------------------- C×–=
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where C is the carbon concentration of the steel. In contrast to the formulation by 
Andrews, the Ae3 temperature line is here linear in the carbon concentration.

T H E  B A I N I T E  S T A R T  T E M P E R A T U R E

Unlike the Ae1 and Ae3 temperatures, the onset of bainite formation does not 
correspond to an equilibrium temperature in the Fe–C diagram. Nevertheless, several 
empirical relationships for a bainite start temperature, Bs, exist in the literature. 
COMSOL Multiphysics provides two models for this temperature. The model by 
Steven and Haynes (Ref. 12) is given by

and the bainite start temperature according to Kirkaldy and Venugopalan (Ref. 10) is 
given by

In the expressions above, it is understood that the alloying elements are expressed in 
terms of their respective weight percentages.

T H E  M A R T E N S I T E  S T A R T  T E M P E R A T U R E

The onset of martensitic transformation is commonly represented by the martensite 
start temperature which is a parameter in the Koistinen–Marburger phase 
transformation model. COMSOL Multiphysics provides two models for the 
martensite start temperature. The model by Andrews (Ref. 11) is given by

and the model by Steven and Haynes (Ref. 12) is given by

In the expressions above, it is understood that the alloying elements are expressed in 
terms of their respective weight percentages.

Note that the Ae1 and Ae3 temperature lines intersect at the eutectoid 
point. The models by Andrews are valid for a carbon concentration less 
than 0.6%, which means that the eutectoid point may be poorly estimated 
by these models.

Bs °C( ) 830 270C– 90Mn– 37Ni– 70Cr– 83Mo–=

Bs °C( ) 656 57.7C– 75Si– 35Mn– 15.3Ni– 34Cr– 41.2Mo–=

Ms °C( ) 539 423C– 30.4Mn– 12.1Cr– 17.7Ni– 7.5Mo–=

Ms °C( ) 561 474C– 33Mn– 17Cr– 17Ni– 21Mo–=
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Equilibrium Phase Fractions

In several of the phase transformation models in COMSOL Multiphysics, a model 
parameter is the equilibrium phase fraction of the destination (forming) phase, . 
When a hypoeutectoid steel is cooled from an austenitic state, ferrite begins to form 
when the temperature falls below Ae3.

Figure 3-6: A schematic Fe–C diagram and the points involved in calculating the 
equilibrium phase fraction of ferrite.

In an Fe–C diagram (Figure 3-6), the equilibrium phase fraction of ferrite in this 
austenite–ferrite two-phase region can be extracted using a simple lever rule as

The formation of free ferrite below the eutectoid temperature Ae1 during quenching 
can be included. COMSOL Multiphysics provides two models of the equilibrium 
phase fraction of ferrite below the eutectoid temperature, see Hippchen and others 
(Ref. 14) for a description. In one model, the equilibrium phase fraction of ferrite is 
taken to be constant below Ae1, and equal to the equilibrium phase fraction at Ae1, see 
Figure 3-7.

ξeq
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ξeq
α a

a b+
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Note that in using the lever rule, the ferrite region above the eutectoid 
temperature Ae1 is taken to be a line from to the ferrite carbon 
solubility, , at Ae1.
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α
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Figure 3-7: A schematic Fe–C diagram showing how the lever rule is used above and below 
eutectoid temperature. On the left, a constant equilibrium phase fraction of ferrite below 
the eutectoid. On the right, the Hultgren extrapolation is used.

In the other model, the equilibrium phase fraction of ferrite is computed by 
considering a modified Fe–C diagram. The Acm line in the Fe–C diagram is 
extrapolated according to Hultgren (Ref. 15). The lever rule is employed using this 
extrapolated line to compute the equilibrium phase fraction, see Figure 3-7. The 
equilibrium phase fraction of ferrite below the eutectoid temperature in the two 
models can be expressed as

To model the formation of pearlite and bainite below the eutectoid temperature, the 
corresponding equilibrium phase fractions are taken to be

Hardness

Maynier and others (Ref. 13) have proposed a method for estimating the Vickers 
hardness (HV) based on the chemical composition of a steel, together with the final 
phase composition and the cooling rate during quenching. The HV hardness is 

ξeq
α c

c d+
------------=

Note that in using the lever rule, the ferrite region below the eutectoid 
temperature Ae1 is taken to be a line from  to the ferrite carbon 
solubility, , at Ae1.

T0
α

Cmax
α

ξeq
p ξeq

b 1 ξeq
α

–= =
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calculated as a dimensionless number, although in its original definition, the unit is 
kgf/mm2. The hardness number is given by a phase fraction weighted sum of the 
hardnesses of the individual metallurgical phases.

where the superscripts f, p, b, and m denote ferrite, pearlite, bainite, and martensite, 
respectively. The hardnesses of the individual phases are given by

where the hardnesses of ferrite and pearlite are taken to be equal. In the expressions 
above, the term Vr is the cooling rate, expressed in K/h, as the temperature passes 700 
degrees Celsius during cooling, and C, Si, Ni, and so forth, are the weight percentages 
of the respective alloying elements.

HV ξf ξp
+( )HVf p+ ξbHVb ξmHVm

+ +=

HVf p+ = 42 223C 53Si 30Mn 12.6Ni 7Cr 19Mo+ + + + + +

+ 10 19Si– 4Ni 8Cr 130V+ + +( ) Vrlog

HVb = 323– 185C 330Si 153Mn 65Ni 144Cr 191Mo+ + + + + +

+ 89 53C 55Si– 22Mn– 10Ni– 20Cr– 33Mo–+( ) Vrlog

HVm 127 949C 27Si 11Mn 8Ni 16Cr 21 Vrlog+ + + + + +=
 3 :  M E T A L  P R O C E S S I N G  T H E O R Y



Compound Ma t e r i a l  P r op e r t i e s

The material consists of a mixture of metallurgical phases, each with a phase fraction 
that is evolving during the analysis. When the Metal Processing Module is used 
together with the Heat Transfer in Solids and Solid Mechanics interfaces, it is of 
interest to compute effective material properties so that a compound material can be 
defined and used by these physics interfaces. This chapter describes how various 
thermal and mechanical properties are averaged in terms of the phase fractions of the 
material.

Heat Transfer Properties

The thermal conductivity and mass density of the compound material are computed 
using linear weighting by the phase fractions. The properties are given by

The thermal conductivity of the compound material uses a full tensor description. The 
heat capacity at constant pressure is computed by using a linear weighting of the 
volumetric heat capacity ρCp, having already computed ρ:

¨

k ξiki

i 1=

N

=

ρ ξiρi

i 1=

N

=

Cp
1
ρ
--- ξiρiCp

i

i 1=

N

=

If geometric nonlinearity is used, k and ρCp are convected to the spatial 
frame in the Heat Transfer in Solids physics interface.
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Electromagnetic Properties

The relative permeability, the electrical conductivity, and the relative permittivity for 
the compound material are computed using a linear weighting by the phase fractions. 
The properties are given by

 (3-23)

 (3-24)

 (3-25)

The electromagnetic properties for the compound material use a full tensor 
description.

Mechanical Properties

The mechanical properties for the compound material are generally computed using 
linear weighting by the phase fractions. The exception is in the case where phase 
plasticity is modeled, where other types of weighting schemes can be used for the initial 
yield strength of the compound material.

E L A S T I C I T Y

The elastic behavior of the compound material is assumed to be isotropic and defined 
by a linear weighting of the Young’s moduli and Poisson’s ratios of the phases. This is 
reasonable because the elastic properties for the different phases are similar at a given 
temperature.

μr ξiμr
i

i 1=

N

=

σ ξiσi

i 1=

N

=

εr ξiεr
i

i 1=

N

=

E ξiEi

i 1=

N

=
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P L A S T I C I T Y

It is not obvious what weighting scheme should be used to define an effective initial 
yield strength because the initial yield strengths of the phases will differ. The following 
weighting scheme is used:

The simplest model for the initial yield strength of the compound material uses a linear 
weighting

This scheme is reasonable when the initial yield strengths are similar. However, it is 
well known that the yield strength of some metallurgical phases can differ significantly. 
Most notably, martensite is typically an order of magnitude harder than austenite, and 
a linear mixture rule is unsuitable. Geijselaers (Ref. 7) developed a weighting scheme 
that is suitable in this situation. In this model, it is assumed that the hardest phase is 
considerably harder than the softest phase. Assuming that the hard phase is m and the 
soft phase is γ, the Geijselaers weighting scheme is given by

with

The hardening function for the compound material is defined using the linear 
weighting

ν ξiνi

i 1=

N

=

σys0 gi ξi( )σys0
i

i 1=

N

=

gi ξi( ) ξi
=

gi ξi( ) ξi, i m≠

fi ξi( ), i=m






=

fm ξm( ) ξm C 2 1 C–( )ξm 1 C–( ) ξm( )
2

–+( )=

C 1.383
σys0

γ

σys0
m
-----------=
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 (3-26)

where  is the equivalent plastic strain of the phase.

E Q U I V A L E N T  P L A S T I C  S T R A I N S

In Equation 3-26, the hardening function for each individual phase depends on 
equivalent plastic strain. If we denote the equivalent plastic strain of the compound 
material , we must define how the equivalent of each phase  evolves with this 
strain. The simplest assumption is to use the evolution equation

which is to say that the equivalent plastic strain of phase i follows that of the compound 
material. If phase transformation and mechanical straining occur simultaneously, the 
equivalent plastic strain of the diminishing source phase of the phase transformation 
can be taken to follow that of the compound material, and this is the behavior in the 
phase transformation physics interfaces. However, for a phase which is increasing in 
fraction during plastic straining, this assumption is questionable. Leblond (Ref. 6) 
derived an evolution equation for the equivalent plastic strain, which is suitable for the 
forming destination phase. The evolution equations for the source and destination 
phases are

where the plasticity memory coefficient  was introduced to model that some 
plastic straining present in the source phase at the instant of transformation will be 
carried over to the forming destination phase. A zero plasticity memory coefficient 
means that no plastic straining will be remembered.

σh ξiσh
i εpe

i( )

i 1=

N

=

εpe
i

εpe εpe
i

ε·pe
i

ε·pe=

ε·pe
s

ε·pe=

ε·pe
d

= ε·pe
ξ·

d

ξd
----- εpe

d Θs d→ εpe
s

–( )–

Θs d→
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Pha s e  T r a n s f o rma t i o n  S t r a i n s

We consider two types of strains that appear during a thermal transient involving 
metallurgical phase transformations. These strains originate from:

• Thermal expansion

• Transformation induced plasticity (TRIP)

Other inelastic strains may also be present during a thermal transient, such as plastic 
strains or creep strains.

Thermal Expansion

Thermal expansion for the compound material is given by a phase fraction weighted 
sum of the thermal expansion of each phase:

It is well known that different metallurgical phases occupy different volumes at a given 
temperature. For example, when austenite transforms into martensite, the thermal 
contraction due to cooling is accompanied by a volumetric expansion when the 
martensite begins to form. Consider a simple case where phase 1 transforms into phase 
2. In 1D, and using a secant definition of the thermal expansion coefficient, the 
thermal strain is

where α(T) and Tref are the secant coefficient of thermal expansion and strain volume 
reference temperature, for the respective phases I and II. Figure 3-8 shows the thermal 
strain. For simplicity, the coefficients of thermal expansion for the two phases in the 
figure are constant (but different). In the figure, a fictitious phase transformation has 
been used to illustrate when phase I transforms completely into phase II as the 
temperature is lowered. No separate volumetric term is required to model this type of 
phase transformation strain, as it is included in the definition of the thermal expansion 
itself.

εth ξiεth
i

i 1=

N

=

εth ξIαI T( ) T Tref
I

–( ) ξIIαII T( ) T Tref
II

–( )+=
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Figure 3-8: Thermal strain during phase transformation.

Transformation-Induced Plasticity

Plastic strains in metals result from deviatoric stresses that exceed the yield strength of 
the material. However, during phase transformations, inelastic strains may appear 
already at very small stress levels. This transformation-induced plasticity (TRIP) is 
therefore different from classical plasticity in that it does not involve a yield criterion 
and that it appears at stress levels that would otherwise be insufficient to cause plastic 
straining even in the softest of the phases. A description of TRIP strain rate, common 
in the literature (see, for example, Ref. 3), is

where the strain rate is proportional to the deviatoric part of the second Piola–
Kirchhoff stress tensor S through the transformation induced plasticity parameter 

, the derivative of the saturation function Φ(ξd), and the rate of the destination 
phase . Values for the transformation-induced plasticity parameter  will 
depend on the type of phase transformation. It can depend on, for example, carbon 
content and temperature (see Ref. 4). Several propositions exist for the saturation 

ε·tp s, d→
3
2
---Ks d→

TRIP dΦ ξd( )

dξd
-------------------ξ·

d
dev S( )⋅ ⋅=

Ks d→
TRIP

ξ·
d

Ks d→
TRIP
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functions; see Table 3-1 and Ref. 9. Through the user-defined option, you can define 
the derivative of the saturation function.

The total TRIP strain rate is given by

Total Strain Contribution

When thermal and TRIP strains are computed, they can be used in a Solid Mechanics 
interface as an inelastic strain contribution. The contributions from thermal and TRIP 
strains are added to form a total strain contribution. In the Solid Mechanics interface, 
this contribution is used additively in the case of an additive strain definition or used 
to form an inelastic-deformation-gradient contribution in the case of geometric 
nonlinearity with nonlinear strains; see Inelastic Strain Contributions. In the latter 
case, the contribution is used multiplicatively.

TABLE 3-1:  SATURATION FUNCTIONS FOR THE TRIP STRAIN RATE.

TYPE EXPRESSION

Abrassart

Desalos ξd(2-ξd)

Leblond ξd(1 − lnξd)) for ξd > 0.03, 
zero otherwise

Tanaka ξd

ξd 3 2 ξd
–( )

ε·tp ε·tp s, d→

s d→
=
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Pha s e  T r a n s f o rma t i o n  L a t e n t  Hea t

The heat rate Q0 that is released during a phase transformation is characterized by the 
enthalpy per unit volume  (see Ref. 4). The heat rate that is associated with 
the transformation of a source phase into a destination phase can be expressed as

 (3-27)

The heat rates that result from each phase transformation are added, and they can be 
used as a heat source when solving the heat equation. A weak contribution is added to 
the weak form of the heat equation:

where  is the sum of the contributions Q0 from each phase transformation 
(Equation 3-27), and T is the temperature degree of freedom used in the Heat 
Transfer in Solids interface.

ΔHs d→

Q0 ΔHs d→ ξ·
d

=

Q̂0δ T( )

Q̂0
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C a r bu r i z a t i o n

Carburization is a heat treatment process where a component is placed in a carbon rich 
atmosphere, at an elevated temperature. During the process, carbon diffuses into the 
surface of the component, and the carbon concentration in the component changes 
with time as carbon continues to diffuse to the interior. The process of carburization 
is modeled using Fick’s second law of diffusion. The carbon concentration c during 
carburization depends on position and time as c = c(X,t), where X denotes material 
coordinates, and t is time. The carbon concentration represents the mass fraction of 
carbon, and it is thus dimensionless. The carbon concentration is governed by the 
following equation:

where D is the diffusion coefficient, or diffusivity. The diffusivity can be specified 
directly, or it can be modeled using an Arrhenius expression of the form

where D0 is a pre-exponential factor, QD is an activation energy, and R is the gas 
constant.

Carbon Potential Model

During carburization, the carbon rich atmosphere can be changed over time to 
produce a desired carbon profile near the surface of the component. In COMSOL 
Multiphysics, you can specify the carbon potential cpot of the surrounding atmosphere 
as a function of time, or you can use a boost-diffuse cycle (Figure 3-9). For the 
boost-diffuse cycle, the carbon potential is defined by

c∂
t∂
----- ∇ D c∇–( )⋅+ 0=

D D0
QD
RT
--------– 

 exp=

cpot
cboost , t tboost≤

cdiffuse , t tboost>






=
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Figure 3-9: The Boost-diffuse cycle.

Boundary Conditions

When a component is subjected to an environment of different carbon concentration, 
carbon can diffuse into or out from its surface. This mass transfer can be modeled in 
two ways:

• A prescribed carbon flux (a Neumann condition): Carbon mass transfer is modeled 
using a convection boundary condition

• A prescribed carbon concentration (a Dirichlet condition): Carbon mass transfer is 
enabled by means of a prescribed value on the surface

A special case of prescribed carbon flux is the case of zero carbon flux.

P R E S C R I B E D  C A R B O N  F L U X

The convective mass transfer of carbon from the environment into a surface with 
outward normal n is given by

where b is the mass transfer coefficient, and cext is the carbon concentration of the 
exterior. A natural way to define the carbon concentration of the exterior is to take it 
as equal to the carbon potential cpot of the surrounding carburizing atmosphere. The 
mass transfer coefficient can be specified directly, or defined as thermally activated

n– D∇c–( )⋅ b cext c–( )⋅=
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where b0 is a pre-exponential factor and Qb is an activation energy. In a given situation, 
these quantities would have to be estimated or measured experimentally.

P R E S C R I B E D  C A R B O N  C O N C E N T R A T I O N

A simple way to model the carbon exchange is to simply prescribe the carbon 
concentration at the surface of the component to be equal to the carbon concentration 
of the exterior. This modeling approach avoids having to characterize the carbon mass 
transfer, but it may instead exaggerate it because the surface will be saturated.

b b0
Qb
RT
--------– 

 exp=
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 4
M e t a l  P h a s e  T r a n s f o r m a t i o n
This chapter describes the Metal Phase Transformation Interface ( ) and its 
functionality. It is found under the Heat Transfer>Metal Processing branch ( ) 
when adding a physics interface.
 73
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Th e  Me t a l  Pha s e  T r a n s f o rma t i o n  
I n t e r f a c e

The Metal Phase Transformation interface ( ) is found under the Heat Transfer>Metal 

Processing ( ) branch when adding a physics interface. The physics interface is 
intended for studying metallurgical phase transformations. You can use this interface 
to study diffusional, displacive, and user-defined (solid state) phase transformations. 
Physical phenomena, such as latent heat of phase transformation and transformation 
strains, can be computed and used in Heat Transfer in Solids and Solid Mechanics. 
With the Nonlinear Structural Materials Module or the Geomechanics Module, plastic 
strains and hardening behavior of each metallurgical phase can be used in Solid 
Mechanics. Different sections of the Settings panel will be active depending on the 
space dimension that the interface is used in, see Table 4-1.

When the Metal Phase Transformation interface is added, three nodes are also added 
to the Model Builder — two Metallurgical Phase nodes and one Phase Transformation 
node. The phase transformation node will be set to use the two metallurgical phases as 
source and destination phases, respectively. From the Physics toolbar, you can add 
additional metallurgical phases and phase transformations. You can also right-click 
Metal Phase Transformation to select physics features from the context menu.

S E T T I N G S

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 

TABLE 4-1:  PHYSICS INTERFACE SECTIONS.

SECTION AVAILABILITY

Material Properties 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Heat Transfer 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Temperature 0D

Solid Mechanics 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Advanced 0D, 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Discretization 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D
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different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is metp.

M A T E R I A L  P R O P E R T I E S

You have the option of letting the physics interface compute effective thermal, 
electromagnetic, and mechanical material properties, based on the corresponding 
properties and fractions of the individual metallurgical phases. Select the Compute 

effective thermal properties check box to let the physics interface compute effective 
thermal properties. Select the Compute effective electromagnetic properties check box 
to let the physics interface compute effective electromagnetic properties. Select the 
Compute effective mechanical properties check box to let the physics interface compute 
effective mechanical properties. You can use the computed effective material properties 
to create a compound material that can be used in other physics interfaces as a domain 
material. Select the Create Compound Material to create a compound material. This 
material is created at the component level.

H E A T  T R A N S F E R

Phase transformations are inherently temperature dependent. Select the temperature 
field to use from the Temperature list. If you want to consider the release or absorption 
of latent heat during phase transformations, select the Enable phase transformation 

latent heat check box. You can then define values for the latent heat at each of the phase 
transformation nodes. By default, the check box is not selected.

T E M P E R A T U R E

Phase transformations are inherently temperature dependent. Enter an expression for 
the temperature to use.

A compound material that is generated from an Austenite Decomposition 
interface (audc) will be given the tag audcmat.

The two sections Heat Transfer and Temperature are mutually exclusive, 
and which one is active is determined by the space dimension.
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S O L I D  M E C H A N I C S

This section contains settings that affect various strains that accompany phase 
transformations. Select the Enable transformation-induced plasticity check box if you 
want to include this type of transformation strain in your analysis. The Enable thermal 

strains and Enable phase plasticity check boxes are visible only if you have selected the 
Compute effective mechanical properties check box in the Material Properties section. 
Select Enable thermal strains if you want to include thermal strains in your analysis. 
Note that the thermal strains will include both pure thermal strains as well as strains 
that arise from volumetric differences between different metallurgical phases. Select 
the Enable phase plasticity check box if you want to allow for plasticity in the individual 
phases. By default, none of the three check boxes in this section are selected.

A D V A N C E D

By default, bounds for computed phase fractions and their sum, are checked during a 
simulation. If you select Advanced Physics Options, the Advanced section is used to 
modify the bounds that are used, or to disable the bounds checking altogether. When 
you have selected Check phase fraction bounds, you can modify the:

• Maximum phase fraction sum, which defines the numerical upper bound for the phase 
fraction sum.

• Minimum phase fraction sum, which defines the numerical lower bound for the phase 
fraction sum.

• Minimum phase fraction, which defines the numerical lower bound for each phase 
fraction, individually.

Normally, you should let COMSOL Multiphysics perform bounds 
checking of the computed phase fractions. Modify the default bounds 
with care, to ensure a valid solution. Disabling the bounds checking 
altogether can be useful during model development, for example when 
implementing your own phase transformation model.
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D I S C R E T I Z A T I O N

The discretization for phase fractions is set using the Discretization for phase fractions 
list. By default, Linear is selected.

Metallurgical Phase

The Metallurgical Phase node defines a phase. Depending on the settings at the physics 
interface level and the space dimension where the physics interface is used, the phase 
node will contain different sections, see Table 4-2.

M O D E L  I N P U T

Provide the Volume reference temperature Tref for the phase. This is the temperature at 
which the thermal strain is zero for the phase.

Note that when you set the Discretization for phase fractions to Gauss 
point data, spatial gradients of the phase fractions will not available. This 
can be relevant in other physics interfaces, should the gradients of phase 
fractions be required.

TABLE 4-2:  METALLURGICAL PHASE SECTIONS.

SECTION AVAILABILITY

Model Input 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Initial Phase Fraction 0D, 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Transformation Times 0D

Phase Material 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Heat Transfer Properties 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D

Electromagnetic Properties 2D, 2D axisymmetric, 3D

Mechanical Properties 1D, 1D axisymmetric, 2D, 2D axisymmetric, 3D
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I N I T I A L  P H A S E  F R A C T I O N

Define the Initial phase fraction for the phase. This fraction should be a value between 
zero and one, and you have to ensure that the initial phase fractions for all the phases 
in your analysis sum to one.

T R A N S F O R M A T I O N  T I M E S

If you select Compute transformation times, you can store the times  and temperatures 
 during an analysis, corresponding to reaching specified target phase fractions. Enter 

a list of Target phase fractions  in the table. Whether transformation times and 
temperatures are recorded depends on if the phase fraction is increasing or decreasing 
during the analysis. Select Decreasing phase fraction if the phase fraction is expected to 
reach the specified target values when it is decreasing. With Compute transformation 

times selected, and in the case a phase fraction is increasing over time, you can select 
Compute time to completion. Enter the Completion rate, that is, a rate of phase 
formation low enough that the formation of the phase can be considered complete.

P H A S E  M A T E R I A L

From the Phase material list, you select the material that defines the material properties 
for the phase. This section is visible only if at least one of the Compute effective thermal 

properties or the Compute effective mechanical properties check boxes has been selected 
at the physics interface level. You can create a material at the component level by using 

• The initial fractions for the metallurgical phases are named 
metp.phase1.xi0, metp.phase2.xi0, and so on.

• The current phase fractions are correspondingly named 
metp.phase1.xi and metp.phase2.xi.

t̂
T̂

ξ̂

If the second Target phase fraction in the table is reached for a 
Metallurgical Phase (phase4) in an Austenite Decomposition interface 
(audc), the corresponding transformation time and temperature will be 
audc.phase4.time_2 and audc.phase4.temperature_2.
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Create Phase Material. When you define material properties for the phase, From material 
will refer to the material that you have selected from the Phase material list.

H E A T  T R A N S F E R  P R O P E R T I E S

If the Compute effective thermal properties has been selected at the physics interface 
level, you must define the thermal properties for the phase. The default Thermal 

conductivity k, Density ρ, and Heat Capacity at constant pressure Cp, use values From 

material. The From material option refers to the selected material from the Phase 

Material list. For User defined, enter values or expressions for these properties.

E L E C T R O M A G N E T I C  P R O P E R T I E S

If the Compute effective electromagnetic properties has been selected at the physics 
interface level, you must define electromagnetic properties for the phase. The default 
Relative permeability μr, Electrical conductivity σ, and Relative permittivity εr, use values 
From material. The From material option refers to the selected material from the Phase 

Material list. For User defined, enter values or expressions for these properties.

M E C H A N I C A L  P R O P E R T I E S

If the Compute effective mechanical properties has been selected at the physics interface 
level, you must define mechanical properties for the phase. The default Young’s 
modulus E and Poisson’s ratio ν use values From material. For User defined, enter values 
or expressions for these properties.

If Enable thermal strains has been selected at the physics interface level, you have to 
define the Secant coefficient of thermal expansion α for the phase. By default, the value 
is taken From material. For User defined, enter a value or expression.

If Enable phase plasticity has been selected at the physics interface level, you have to 
define the plastic behavior of the phase. The default Initial yield stress σys0 uses a value 
From material. For User defined, enter another value or expression for initial yield stress. 
Initial yield stresses for phases can be weighted differently. This is useful when initial 
yield stresses for the phases in the model are very different. Select a Weight factor for 

yield stress — Linear, Geijselaers, or User defined. If Geijselaers is selected, you also need 
to specify a Soft phase, which is considered plastically soft in comparison to this phase. 

A phase material that is generated from a Metallurgical Phase (phase2) in 
an Austenite Decomposition interface (audc) will be given the tag 
audcphase2mat.
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You should typically use this to give a stronger weight to martensite (hard) in relation 
to austenite (soft).

Select the Isotropic hardening model — Perfectly plastic, Linear, or User defined to define 
the hardening behavior of the phase.

Linear
Specify the Isotropic hardening modulus ETiso. The default value is taken From material. 

User defined
For User defined, enter another value or expression for the modulus. If a User defined 
isotropic hardening modulus is selected, you have to select the Hardening function. By 
default, the value is taken From material.

For User defined, enter a value or expression for the hardening function. The expression 
can depend, for example, on the equivalent plastic strain in the phase.

Phase Transformation

Depending on the settings at the physics interface level and the space dimension where 
the physics interface is used, the phase transformation node will contain different 
sections.

P H A S E  T R A N S F O R M A T I O N

The phase transformation defines how one phase forms (the destination phase) at the 
expense of another (the source phase). Select Source phase ξs and Destination phase ξd 
from the list of defined phases. Select a Phase transformation model — Leblond–Devaux, 
Johnson–Mehl–Avrami–Kolmogorov, Kirkaldy–Venugopalan, Koistinen–Marburger, 
Hyperbolic rate, or User defined.

Leblond–Devaux
Select a Formulation — Time and equilibrium, General coefficients, TTT diagram data, or 
Parameterized TTT diagram.

• For Time and equilibrium, select an Equilibrium phase fraction  from the list. For 
User defined, specify an expression for . Specify a Time constant τs → d.

In a phase (phase4) of an Austenite Decomposition interface (audc), the 
equivalent plastic strain is audc.phase4.epe.

ξeq
d

ξeq
d
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• For General coefficients, specify the expressions for Ks → d and Ls → d. For TTT 

diagram data, select an Equilibrium phase fraction  from the list. For User defined, 
specify an expression for . Specify the Relative phase fraction X1, and the 
Transformation time t1.

• For Parameterized TTT diagram, select an Equilibrium phase fraction  from the list. 
For User defined, specify an expression for . Specify the Relative phase fraction 
X1. In the TTT Curve 1 section, specify the transformation times tL, tN, and tU 
corresponding to points on the lower part, the “nose”, and the upper part of the 
TTT curve at the relative phase fraction X1. Specify the corresponding 
transformation temperatures TL, TN, and TU, and the TTT curve shape parameters 
qNL and qNU.

If applicable, select Define temperature limits, and select the Lower temperature limit Tl 
and the Upper temperature limit Tu from the respective lists. For the User defined 
options, specify, respectively, expressions for Tl and Tu.

Johnson–Mehl–Avrami–Kolmogorov
Select a Formulation — Time, equilibrium and exponent, TTT diagram data, TTT diagram 

data, fixed exponent, Parameterized TTT diagram, or Parameterized TTT diagram, fixed 

exponent.

• For Time, equilibrium and exponent, select an Equilibrium phase fraction  from the 
list. For User defined, specify an expression for . Specify the Time constant τs → d, 
and the Avrami exponent ns → d.

• For TTT diagram data, select an Equilibrium phase fraction  from the list. For User 

defined, specify an expression for . Specify the Relative phase fraction X1, the 
Transformation time t1, the Relative phase fraction X2, and the Transformation time t2.

• For TTT diagram data, fixed exponent, select an Equilibrium phase fraction  from 
the list. For User defined, specify an expression for . Specify the Avrami exponent 
ns → d, the Relative phase fraction X1, and the Transformation time t1.

• For Parameterized TTT diagram, select an Equilibrium phase fraction  from the list. 
For User defined, specify an expression for . Specify the Relative phase fraction 
X1, and the Relative phase fraction X2. In the TTT Curve 1 section, specify the 
transformation times tL, tN, and tU corresponding to points on the lower part, the 

ξeq
d

ξeq
d

ξeq
d

ξeq
d

The Equilibrium phase fraction, Lower temperature limit, and Upper 

temperature limit lists used by phase transformation nodes are populated 
by values calculated by the Steel Composition node.

ξeq
d

ξeq
d

ξeq
d

ξeq
d

ξeq
d

ξeq
d

ξeq
d

ξeq
d

T H E  M E T A L  P H A S E  T R A N S F O R M A T I O N  I N T E R F A C E  |  81



82 |  C H A P T E R
“nose”, and the upper part of the TTT curve at the Relative phase fraction X1. 
Specify the corresponding transformation temperatures TL, TN, and TU, and the 
TTT curve shape parameters qNL and qNU. In the TTT Curve 2 section, specify the 
parameters for the TTT curve at the Relative phase fraction X2.

• For Parameterized TTT diagram, fixed exponent, select an Equilibrium phase fraction 
 from the list. For User defined, specify an expression for . Specify the Avrami 

exponent ns → d, and the Relative phase fraction X1. In the TTT Curve 1 section, 
specify the transformation times tL, tN, and tU corresponding to points on the lower 
part, the “nose”, and the upper part of the TTT curve at the Relative phase fraction 
X1. Specify the corresponding transformation temperatures TL, TN, and TU, and 
the TTT curve shape parameters qNL and qNU.

If the rate term in the phase transformation model is to account for a nonzero initial 
phase fraction of the source phase, select Include effect of initial phase fraction. If 
applicable, select Define temperature limits, and select the Lower temperature limit Tl 
and the Upper temperature limit Tu from the respective lists. For the User defined 
options, specify, respectively, expressions for Tl and Tu.

Kirkaldy–Venugopalan
Select a Formulation — Rate coefficient, TTT diagram data, or Parameterized TTT diagram. 

• For Rate coefficient, select an Equilibrium phase fraction  from the list. For User 

defined, specify an expression for . Specify the Reference rate .

• For TTT diagram data, select an Equilibrium phase fraction  from the list. For User 

defined, specify an expression for . Specify the Relative phase fraction X1, and the 
Transformation time t1.

• For Parameterized TTT diagram, select an Equilibrium phase fraction  from the list. 
For User defined, specify an expression for . Specify the Relative phase fraction 
X1. In the TTT Curve 1 section, specify the transformation times tL, tN, and tU 
corresponding to points on the lower part, the “nose”, and the upper part of the 
TTT curve at the relative phase fraction X1. Specify the corresponding 
transformation temperatures TL, TN, and TU, and the TTT curve shape parameters 
qNL and qNU.

The rate term can be modified from its original form. If applicable, select Include 

retardation term, and specify the Retardation coefficient Cr. If applicable, select Define 

temperature limits, and select the Lower temperature limit Tl and the Upper temperature 

limit Tu from the respective lists. For the User defined options, specify, respectively, 
expressions for Tl and Tu.

ξeq
d ξeq

d

ξeq
d

ξeq
d ξ·0
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Koistinen–Marburger
Select a Formulation — Koistinen–Marburger coefficient or Martensite finish temperature. 

• For Koistinen–Marburger coefficient, specify the Martensite start temperature Ms and 
the Koistinen–Marburger coefficient β.

• For Martensite finish temperature, specify the Martensite start temperature Ms and 
the Martensite finish temperature M90.

Hyperbolic rate
Specify the Hyperbolic rate constant Ps → d and select an Equilibrium phase fraction  
from the list. For User defined, specify an expression for . If applicable, select Define 

temperature limits, and select the Lower temperature limit Tl and the Upper temperature 

limit Tu from the respective lists. For the User defined options, specify, respectively, 
expressions for Tl and Tu.

User defined
Specify the Phase transformation contribution As → d. The expression defines the rate at 
which the destination phase forms, at the expense of the source phase.

If applicable, select Define temperature limits, and select the Lower temperature limit Tl 
and the Upper temperature limit Tu from the respective lists. For the User defined 
options, specify, respectively, expressions for Tl and Tu.

P H A S E  T R A N S F O R M A T I O N  L A T E N T  H E A T

This section is active if you have selected Enable phase transformation latent heat at the 
physics interface level. You can specify the latent heat ΔHs → d that is released during 
the phase transformation.

P H A S E  T R A N S F O R M A T I O N  S T R A I N

The Transformation induced plasticity check box is available if you have selected Enable 

transformation induced plasticity at the physics interface level. In case of transformation 
induced plasticity, specify the Transformation induced plasticity parameter  and 
the Saturation function Φ.

The Plastic recovery for destination phase check box is available if the Enable thermal 

strains has been selected at the physics interface level. If you have selected Plastic 

recovery for destination phase, you can specify the Plastic memory coefficient Θs → d. 

ξeq
d

ξeq
d

Ks d→
TRIP
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The default value is zero, which means that no plastic straining in the source phase will 
be carried over to the destination phase.

A D V A N C E D

Numerical smoothing can be applied at temperatures that correspond to a sudden 
activation or deactivation of the phase transformation. If you select Advanced Physics 

Options, the Advanced section is used to assign smoothing:

• Transformation temperature smoothing, ΔT, in case you have used Define temperature 

limits.

• Martensite start temperature smoothing, ΔMs, in the case of the Koistinen–Marburger 
phase transformation model.

The smoothing parameters ΔT and ΔMs each defines a temperature span across which 
the phase transformation rate term is smoothly ramped. In the limit of a zero 
smoothing parameter value, the ramping reduces to a Heaviside step function.

Transformation Condition

One or several Transformation Condition subnodes can be added to a Phase 

Transformation node. In the Transformation Condition subnode, specify a Boolean 
expression c that has to be satisfied for the Phase Transformation to take place. For 
example, if you have reason to prevent a phase transformation from occurring unless 
the temperature rate is negative, the expression could look like:

metp.Tt<0[K/s]

If you have selected Parameterized TTT Diagram or Parameterized TTT 

Diagram, Fixed Exponent, you can visualize the TTT curve corresponding 
to the entered parameters in the TTT curve 1 or TTT Curve 2 sections.

• Make a preview plot by selecting TTT curve preview.

• Generate a plot by selecting Create TTT curve plot.
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If several Transformation Condition subnodes are used, each separate condition has to 
be satisfied for the Phase Transformation to take place.

Additional Source Phase

One or several Additional Source Phase subnodes can be added to a Phase Transformation 
node. In the Additional Source Phase subnode, select a metallurgical phase that 
contributes to the formation of the Destination phase defined in the Phase 

Transformation node.

Steel Composition

The Steel Composition node is used to specify the chemical composition of a steel in 
terms of weight percentages of its alloying elements. Different empirical relationships 
are then used to establish characteristic transformation temperatures to be used in 
phase transformation modeling. In addition, the equilibrium phase fractions of 
metallurgical phases are computed as functions of temperature.

S T E E L  C O M P O S I T I O N

In the table Weight percent of alloying elements, specify the weight percentage (wt%) of 
each alloying element. For example, type 0.4 for Carbon for a steel with 0.4 percent 
carbon by weight (wt%).

D E F I N I T I O N S

This section is used to specify the particular models used to compute composition 
dependent phase transformation temperatures.

• Under Ae1 and Ae3 temperatures, specify how to model the Ae1 and Ae3 lines of an 
iron–carbon (Fe–C) diagram. If Andrews is selected, (constant) Ae1 and (nonlinear) 
Ae3 temperature lines are computed using empirical relationships based on the 

In some situations, a Boolean expression c may be numerically 
challenging. It can be beneficial to use smoothed transformation 
condition. For example, a general Boolean expression a > b can be 
replaced by a smoothed Heaviside function as

flc1hs(2*(a-b)/h, 1)

causing c to increase smoothly from zero to one, across an interval of 
length h, centered at a = b.
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specified alloying content of the steel. If Parameterized is selected, (constant) Ae1 
and (linear) Ae3 temperature lines are given in terms of three characteristic values. 
Specify the carbon concentration at the eutectoid, , the Ae3 temperature at 
zero carbon concentration, , and the Ae1 temperature.

• Under Bainite start temperatures, specify how to model the bainite start 
temperature. Select Steven–Haynes Bs or Kirkaldy–Venugopalan Bs.

• Under Martensite start temperatures, specify how to model the martensite start 
temperature. Select Andrews Ms or Steven–Haynes Ms.

Select Calculate equilibrium phase fractions to compute the equilibrium phase fraction 
of ferrite, as well as equilibrium phase fractions for pearlite and bainite.

E Q U I L I B R I U M  P H A S E  F R A C T I O N S

This section is available if Calculate equilibrium phase fractions has been selected. Specify 
the maximum ferrite solubility (at the eutectoid temperature), . Under Ferrite 
formation below the eutectoid, specify how ferrite is formed below the temperature Ae1. 
Select None to set the ferrite equilibrium phase fraction to zero below the eutectoid (no 
formation of free ferrite). Select Constant to set the ferrite equilibrium phase fraction 
below the eutectoid equal to that at the eutectoid temperature. Select Hultgren 

extrapolation to model the ferrite equilibrium phase fraction based on the linear 
extrapolation method by Hultgren. For Hultgren extrapolation, specify the lowest 
temperature of the ferrite region in the Fe–C diagram, , and the lowest temperature 
for the formation of free ferrite, TC.

Hardness

The Hardness subnode is used to compute the Vickers hardness (HV) of steel, after 
cooling from an austenitic state. One or several Hardness subnodes can be added to a 
Steel Composition node. In the Hardness subnode, you select the metallurgical phases 
that represent, respectively, ferrite, pearlite, bainite, and martensite. Based on this 
information, the chemical composition of the steel defined in the parent Steel 

Ceut
γ

Ae3
0

Transformation Temperatures

Cmax
α

T0
α

Equilibrium Phase Fractions
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Composition node, and certain characteristics of the cooling transient, the hardness is 
computed.

Hardness
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 5
A u s t e n i t e  D e c o m p o s i t i o n
This chapter describes the Austenite Decomposition Interface ( ) and its 
functionality. It is found under the Heat Transfer>Metal Processing branch ( ) 
when adding a physics interface.
 89
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Th e  Au s t e n i t e  De c ompo s i t i o n  
I n t e r f a c e

The Austenite Decomposition interface ( ) is found under the Heat Transfer>Metal 

Processing ( ) branch when adding a physics interface. The physics interface is 
intended for studying metallurgical phase transformations. You can use this interface 
to study diffusional, displacive, and user-defined (solid-solid) phase transformations. 
Physical phenomena, such as latent heat of phase transformation and transformation 
strains can be computed and used in Heat Transfer in Solids and Solid Mechanics. With 
the Nonlinear Structural Materials Module or the Geomechanics Module, plastic 
strains and hardening behavior of each metallurgical phase can be used in Solid 
Mechanics.

This interface is based on the Metal Phase Transformation interface. This chapter will 
only describe the nodes and settings that set the Austenite Decomposition interface 
apart from the Metal Phase Transformation interface. With regard to other settings at 
the physics interface level and feature level, see The Metal Phase Transformation 
Interface.

When the Austenite Decomposition interface is added, nine nodes are added to the 
Model Builder — five Metallurgical Phase nodes and four Phase Transformation nodes. 
The interface is tailored specifically to the decomposition of austenite into a 
combination of ferrite, pearlite, bainite, and martensite. The phase nodes are given 
names to reflect this:

• Austenite

• Ferrite

• Pearlite

• Bainite

• Martensite

The Initial Phase Fraction is set to one in the Austenite node, and zero in the other 
metallurgical phase nodes. Four Phase Transformation nodes are also created to define 
the relevant phase transformations:

• Austenite to Ferrite

• Austenite to Pearlite
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• Austenite to Bainite

• Austenite to Martensite

The source and destination phases in each phase transformation are set to the 
corresponding phases that have been created. The Phase transformation model is set to 
Leblond–Devaux with General coefficients, except in Austenite to Martensite, where it is 
set to Koistinen–Marburger.

From the Physics toolbar, you can delete or disable metallurgical phases and phase 
transformations that are irrelevant in a given situation, and you can add additional 
metallurgical phases and phase transformations. You can also right-click Austenite 

Decomposition to select physics features from the context menu.

S E T T I N G S

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is audc.

A Parameters node is automatically created under Global Definitions. This 
node contains parameters for certain user inputs of the physics interface 
nodes.
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 6
A l p h a – B e t a  P h a s e  T r a n s f o r m a t i o n
This chapter describes the Alpha–Beta Phase Transformation Interface ( ) and 
its functionality. It is found under the Heat Transfer>Metal Processing branch ( ) 
when adding a physics interface.
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T h e  A l p h a–Be t a  Pha s e  
T r a n s f o rma t i o n  I n t e r f a c e

The Alpha–Beta Phase Transformation interface ( ) is found under the Heat 

Transfer>Metal Processing ( ) branch when adding a physics interface. The physics 
interface is intended for studying metallurgical phase transformations in α–β titanium 
alloys. You can use this interface to study diffusional, displacive, and user-defined 
(solid-solid) phase transformations. Physical phenomena, such as latent heat of phase 
transformation and transformation strains can be computed and used in Heat Transfer 
in Solids and Solid Mechanics. With the Nonlinear Structural Materials Module or the 
Geomechanics Module, plastic strains and hardening behavior of each metallurgical 
phase can be used in Solid Mechanics.

This interface is based on the Metal Phase Transformation interface. This chapter will 
only describe the nodes and settings that set the Alpha–Beta Phase Transformation 
interface apart from the Metal Phase Transformation interface. With regard to other 
settings at the physics interface level and feature level, see The Metal Phase 
Transformation Interface.

When the Alpha–Beta Phase Transformation interface is added, several nodes are 
added to the Model Builder — three Metallurgical Phase nodes and seven Phase 
Transformation nodes. The interface is tailored specifically to the phase 
transformations that can take place in α–β titanium alloys like Ti–6Al–4V. The Alpha–
Beta Phase Transformation interface defines three major phases, whose node names 
are:

• Beta

• Widmanstätten Alpha

• Martensitic Alpha

Phase transformation modeling of α–β titanium alloys sometimes 
includes an alpha phase that forms at the beta grain boundaries. This 
alpha phase is omitted here, as it often exists in small fractions. Should this 
level of modeling detail be warranted, additional metallurgical phase and 
phase transformation nodes can be added to the interface.
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The Initial Phase Fraction is set to 0.11 in the Beta node, and 0.89 in the Widmanstätten 

Alpha node. These initial phase fractions are approximate values corresponding to an 
α–β titanium alloy like Ti–6Al–4V, at room temperature. Seven Phase Transformation 
nodes are also created to define the relevant phase transformations:

• Beta to Widmanstätten Alpha. This phase transformation is active under isothermal 
or cooling conditions, and it is active provided that the fraction of beta phase 
exceeds its equilibrium value.

• Beta to Martensitic Alpha (Fast). This phase transformation is active under cooling 
conditions, when the cooling rate exceeds a certain threshold rate, and below the 
Martensite start temperature.

• Beta to Martensitic Alpha (Slow). This phase transformation is active under cooling 
conditions, when the cooling rate is lower than the threshold rate mentioned above, 
and below the Martensite start temperature. Under these conditions, the maximum 
fraction of formed Martensitic alpha is limited by the equilibrium value of beta 
phase.

• Alpha to Beta. This phase transformation is used to model the dissolution of 
Widmanstätten and Martensitic alpha, into beta phase. It is active under heating 
conditions, and when the temperature exceeds the so-called beta start temperature.

• Martensitic Alpha to Beta. This phase transformation represents the dissolution of 
Martensitic alpha into beta phase. It is active at temperatures above the martensite 
dissolution temperature. In this phase transformation, the beta phase strives toward 
its equilibrium value.

• Martensitic Alpha to Widmanstätten Alpha. This phase transformation represents 
the dissolution of Martensitic alpha into Widmanstätten alpha phase. It is active at 
temperatures above the martensite dissolution temperature. In this phase 
transformation, the Widmanstätten alpha phase strives toward its equilibrium value.

• Beta Re-Formation. This phase transformation represents a simplified description of 
complete dissolution of alpha phase. It is active when the temperature exceeds the 
beta transus.

A Parameters node is automatically created under Global Definitions. This 
node contains parameters for certain user inputs of the physics interface 
nodes. Generated parameters include default values for characteristic 
transformation temperatures, for the Martensitic alpha rate threshold, etc.
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From the Physics toolbar, you can delete or disable metallurgical phases and phase 
transformations that are irrelevant in a given situation, and you can add additional 
metallurgical phases and phase transformations. You can also right-click Alpha–Beta 

Phase Transformation to select physics features from the context menu.

S E T T I N G S

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is abp.

For an example how to model phase transformation that occur during 
welding of a titanium plate, see Welding of a Titanium Plate: 
Application Library path 
Metal_Processing_Module/Titanium_Phase_Transformations/welding_of_a_tit

anium_plate.
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 7
C a r b u r i z a t i o n
This chapter describes the Carburization interface ( ) and its functionality. It is 
found under the Heat Transfer>Metal Processing branch ( ) when adding a physics 
interface.
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Th e  C a r bu r i z a t i o n  I n t e r f a c e

The Carburization interface ( ) is found under the Heat Transfer>Metal Processing 
( ) branch when adding a physics interface. The physics interface is intended for 
modeling carburization processes during heat treatment. The carburization process is 
based on diffusion, and it is used to compute the evolving mass fraction of carbon 
when a component is exposed to a carbon rich atmosphere.

When the Carburization interface is added, three default nodes are added to the Model 

Builder — a Carburization node, an Initial Values node, and a Zero Carbon Flux node.

S E T T I N G S

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is carb.

T E M P E R A T U R E

Carbon diffusion is inherently temperature dependent. Select the temperature field to 
use from the Temperature list.

C A R B U R I Z I N G  C Y C L E

This section contains settings for the carburization process. Select the carbon potential 
model to use from the Carbon potential model list. Select Boost-diffuse cycle if you want 
to model a two-stage carburization process, where a boost stage is followed by a diffuse 
stage. Define the Boost carbon potential cboost, the Diffuse carbon potential cdiffuse, and 
the Boost period tboost. Select User defined if you want to use your own expression for 
the carbon potential of the carburization process. Define the Carbon potential cpot.

Carburization

The Carburization node defines the carbon diffusion inside the domain.
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C A R B O N  D I F F U S I O N

From the Diffusion coefficient list you select the diffusion coefficient that is used in the 
diffusion equation. Select Arrhenius to define a thermally activated diffusion 
coefficient. Define the Pre-exponential factor D0 and the Activation energy QD. Select 
User defined to define the Diffusion coefficient D directly.

Carbon Flux

The Carbon Flux node is used to define the carbon exchange with the surrounding 
carbon atmosphere (the exterior).

C A R B O N  M A S S  T R A N S F E R

From the Carbon potential list, select the carbon potential of the exterior cext. Select 
Carbon potential to use the carbon potential defined at the physics interface level. Select 
User defined to define the carbon potential directly. From the Mass transfer coefficient 
list, select the mass transfer coefficient to be used to define the carbon flux. Select 
Arrhenius to define a thermally activated mass transfer coefficient. Define the 
Pre-exponential factor b0 and the Activation energy Qb. Select User defined to define the 
Mass transfer coefficient b directly.

Zero Carbon Flux

The Zero Carbon Flux node is used to define boundaries where no carbon exchange 
takes place with the exterior.

Carbon Concentration

The Carbon Concentration node is used to specify the carbon concentration at an 
exterior domain boundary.

C A R B O N  C O N C E N T R A T I O N

From the list, select the carbon concentration c0. Select Carbon potential to use the 
carbon potential defined at the physics interface level. Select User defined to specify the 
carbon concentration c0 directly.

Initial Values

The Initial Values node is used to specify the initial carbon concentration c.
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 8
M u l t i p h y s i c s  I n t e r f a c e s  a n d  C o u p l i n g s
The Metal Processing Module contains predefined multiphysics interfaces to 
facilitate the coupling to Heat Transfer in Solids and Solid Mechanics interfaces. 
The physics interfaces are found under the Heat Transfer>Metal Processing branch 
( ) when adding a physics interface — Heat Transfer with Phase Transformations 

and Steel Quenching. Two multiphysics coupling features — Phase Transformation 

Latent Heat and Phase Transformation Strain, can be added to facilitate the coupling 
to Heat Transfer in Solids and Solid Mechanics.

In this chapter:

• Heat Transfer with Phase Transformations

• Steel Quenching

• Phase Transformation Latent Heat Multiphysics Coupling

• Phase Transformation Strain Multiphysics Coupling
 |  101
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Hea t  T r a n s f e r  w i t h  Pha s e  
T r a n s f o rma t i o n s

The Heat Transfer with Phase Transformations multiphysics interface ( ) combines a 
Heat Transfer in Solids interface with a Metal Phase Transformation interface. When 
the Heat Transfer with Phase Transformations multiphysics interface is added, the 
multiphysics coupling Phase Transformation Latent Heat is included.

On the Constituent Physics Interfaces

• The Heat Transfer in Solids interface is described in The Heat Transfer in Solids 
Interface of the Heat Transfer Module User’s Guide.

• The Metal Phase Transformation interface is described in The Metal Phase 
Transformation Interface chapter.

S E T T I N G S  F O R  P H Y S I C S  I N T E R F A C E S  A N D  C O U P L I N G  F E A T U R E S

The Enable phase transformation latent heat check box is selected in the Metal Phase 
Transformation interface.
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S t e e l  Quen ch i n g

The Steel Quenching multiphysics interface ( ) combines a Heat Transfer in Solids 
interface with an Austenite Decomposition interface and a Solid Mechanics interface. 
When the Steel Quenching multiphysics interface is added, the Phase Transformation 

Latent Heat and Phase Transformation Strain multiphysics couplings are included.

On the Constituent Physics Interfaces

• The Heat Transfer in Solids interface is described in The Heat Transfer in Solids 
Interface.

• The Austenite Decomposition interface is described in The Austenite 
Decomposition Interface chapter.

• The Solid Mechanics interface is described in The Solid Mechanics Interface of the 
Structural Mechanics Module User’s Guide.

S E T T I N G S  F O R  P H Y S I C S  I N T E R F A C E S  A N D  C O U P L I N G  F E A T U R E S

The following check boxes are selected in the Austenite Decomposition interface:

• Compute effective thermal properties

• Compute effective mechanical properties

• Enable phase transformation latent heat

• Enable transformation induced plasticity

• Enable thermal strains

The discretization for the temperature field in the Heat Transfer in Solids interface is 
set to Linear, because thermal strains are typically linear in the Solid Mechanics 
interface.
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Pha s e  T r a n s f o rma t i o n  L a t e n t  Hea t  
Mu l t i p h y s i c s  C oup l i n g

The Phase Transformation Latent Heat multiphysics coupling ( ) is used to add the 
latent heat that is produced by a phase transformation physics interface as a heat source 
term in the heat equation of the coupled Heat Transfer in Solids interface. When the 
coupling is used, no separate Heat Source feature in the Heat Transfer interface is 
required.

S E T T I N G S

The Label is the default multiphysics coupling feature name.

The Name is used primarily as a scope prefix for variables defined by the coupling node. 
Refer to such variables in expressions using the pattern <name>.<variable_name>. In 
order to distinguish between variables belonging to different coupling nodes or physics 
interfaces, the name string must be unique. Only letters, numbers, and underscores (_) 
are permitted in the Name field. The first character must be a letter.

The default Name (for the first multiphysics coupling feature in the model) is lht1.

D O M A I N  S E L E C T I O N

When the coupling is added, selected entities in the coupled Heat Transfer in Solids 
and Metal Phase Transformation interfaces are included by default.

C O U P L E D  I N T E R F A C E S

This section defines the physics involved in the multiphysics coupling. The Metal Phase 

Transformation and Heat Transfer lists include all applicable physics interfaces.

When the Phase Transformation Latent Heat multiphysics coupling is used, 
the effect of latent heat should not be added as a Heat Source in the Heat 
Transfer in Solids interface, as this incorrectly amounts to adding the 
latent heat contribution twice.
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The default values depend on how the coupling node is created.

• If the node is added from the Physics ribbon (Windows users), Physics contextual 
toolbar (Mac and Linux users), or context menu (all users), then the first physics 
interface of each type in the component is selected as the default.

• If it the node added automatically when a multiphysics interface is selected in the 
Model Wizard or Add Physics window, then the two participating physics interfaces 
are selected.

See also the Theory for Phase Transformation Latent Heat
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Pha s e  T r a n s f o rma t i o n  S t r a i n  
Mu l t i p h y s i c s  C oup l i n g

The Phase Transformation Strain multiphysics coupling ( ) is used to include phase 
transformation strains that are produced by a phase transformation physics interface as 
an inelastic strain contribution to the total strain in the Solid Mechanics interface.

S E T T I N G S

The Label is the default multiphysics coupling feature name.

The Name is used primarily as a scope prefix for variables defined by the coupling node. 
Refer to such variables in expressions using the pattern <name>.<variable_name>. In 
order to distinguish between variables belonging to different coupling nodes or physics 
interfaces, the name string must be unique. Only letters, numbers, and underscores (_) 
are permitted in the Name field. The first character must be a letter.

The default Name (for the first multiphysics coupling feature in the model) is ptstr1.

D O M A I N  S E L E C T I O N

When the coupling is added, selected entities in the coupled Solid Mechanics and 
Metal Phase Transformation interfaces are included by default.

C O U P L E D  I N T E R F A C E S

This section defines the physics involved in the multiphysics coupling. The Metal Phase 

Transformation and Solid Mechanics lists include all applicable physics interfaces.

Note that if Enable thermal strains has been selected at the Metal Phase 

Transformation interface level, thermal strain effects are included in the 
phase transformation strains. In this situation no Thermal Expansion 
coupling should be used between Solid Mechanics and Heat Transfer in 
Solids.
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The default values depend on how the coupling node is created.

• If the node is added from the Physics ribbon (Windows users), Physics contextual 
toolbar (macOS and Linux users), or context menu (all users), then the first physics 
interface of each type in the component is selected as the default.

• If it the node added automatically when a multiphysics interface is selected in the 
Model Wizard or Add Physics window, then the two participating physics interfaces 
are selected.

T I M E  S T E P P I N G  F O R  S T R A I N S

This section is used to specify how TRIP strains and plastic strain recovery are 
computed. Under Method, select Local ODEs or Domain ODEs. For Local ODEs, the TRIP 
strains and the plastic recovery are computed using state variable based local Newton 
iterations, and no additional degrees of freedom are added to the model. For Domain 

ODEs, the TRIP strains and the plastic recovery are computed using domain level 
ODEs, and corresponding degrees of freedom are added to the model.

A D V A N C E D  S E T T I N G S

To enable this section, click the Show More Options button ( ) and select Show 

Advanced Physics Options in the Show More Options dialog box. The section is shown if 
the selected Method under Time Stepping For Strains is Local ODEs. Normally these 
settings do not need to be changed.

For the Local ODEs method, you can make the following settings:

• Maximum number of local iterations. This defines the maximum number of iterations 
of the Newton loop when solving the local strain equations.

• Absolute tolerance. This defines the absolute tolerance for convergence of the local 
strain equations. Convergence is judged based on the step size, that is, the size of 
the Newton correction, of each equation.

• Relative tolerance. This defines the relative tolerance for convergence of the local 
strain equations. Convergence is judged based on the step size, that is, the size of 
the Newton correction, of each equation.

See also the Theory for Phase Transformation Strains
P H A S E  T R A N S F O R M A T I O N  S T R A I N  M U L T I P H Y S I C S  C O U P L I N G  |  107



108 |  C H A P T E R
Annealing

The Annealing subnode to the Phase Transformation Strain multiphysics coupling is 
used to specify an annealing temperature above which plastic hardening variables 
(equivalent plastic strains) are set to zero.

A N N E A L I N G

Specify the Annealing temperature, Ta.

• The Annealing subnode can only be used with the Local ODEs method 
under Time Stepping for Strains of the parent multiphysics coupling.

• The Annealing subnode must be used in conjunction with Annealing 
subnodes to Plasticity nodes of the coupled Solid Mechanics interface. 
The selection of the former subnode must match the aggregate 
selection of the latter.
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